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TENTANG PENULIS «..vvvevveeeesesesessesssesssesssesesssessssssssssessssssssssssnssssssens 208 ity adalah game engine yang cukup dikenal. Game engine ini telah

mnyak digunakan baik dari kalangan pelajar maupun penggiat game
Indie. Anda dapat menggunakan Unity untuk membuat game 2D atau
JD. Pada bab ini Anda akan dikenalkan terlebih dahulu apa itu Unity dan
tlasar-dasar cara menggunakannya.

1.1 Game Engine

Game engine adalah sebuah software dengan framework yang
‘ digunakan untuk membuat atau mengembangkan game. Banyak hal
yang dimiliki game engine untuk membuat game, seperti membuat
gambar karakter, efek tabrakan, koding, musik, animasi, dan lain
sebagainya.

Kelebihan membuat game menggunakan game engine adalah Anda
akan lebih mudah dalam membuat game. Hal ini karena game engine
telah menyediakan berbagai kebutuhan untuk membuat game.
Selanjutnya, Anda hanya perlu mengatur jalannya game seperti yang
Anda inginkan. Game yang dapat dibuat oleh game engine tidak hanya
game untuk komputer, tetapi juga dapat digunakan untuk konsol atau
mobile.
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Ada banyak game engine saat ini. Bagi Anda yang tertarik membual

game dengan game engine, Anda dapat mencoba beberapa gamm
engine berikut:

» Unity

» Cry Engine v
» Construct

» GameMaker Studio

» RPG Maker

» Unreal

» Luminous Studio

» Crystal Tool

Gambar 1.1 Final Fantasy XV menggunakan Luminous Studio

Dari uraian di atas, Anda dapat melihat banyak sekali game engine. Dari
semua game engine, untuk bisa membuat game ada persamaan syarat
yang diperlukan, yaitu Anda perlu memahami script dari setiap game

engine. Hal ini karena, Anda mengatur berjalannya game dengan
menggunakan script.

Pada buku ini Anda akan dijelaskan cara membuat game menggunakan
Unity. Game engine ini merupakan game engine yang cukup banyak

digunakan oleh pembuat game indie maupun orang yang baru belajar
membuat game.

nity 3D

ang bukan game engine yang digunakan untuk membuat
atas seperti Final Fantasy XV yang sedang dibuat
kan Luminous atau Far Cry yang menggunakan Cry Engine.
pl, bagi Anda yang ingin belajar membuat game, Unity
n pilihan yang tepat. Hal ini karena Unity memberikan
san Anda untuk membuat game yang Anda inginkan. Selain, itu
Juga cukup kompleks untuk membuat berbagai macam jenis
. Sebut saja Anda dapat membuat game dengan tema balap,
ngan, olah raga, atau role playing.

an utama dari Unity yang cocok bagi Anda yang belajar membuat
adalah tersedianya versi gratis. Selain versi gratis, Unity juga
yediakan asset store yang berisi asset atau perlengkapan untuk
buat game yang dapat langsung digunakan. Asset yang tersedia di
antara lain bentuk karakter, tampilan peta, skrip, dan lain

“ CUBED3 rani

Gambar 1.2 Deus EX: The Fall yang dibuat menggunakan Unity

1.3 Instalasi Unity

Sebelum Anda menginstal Unity, Anda perlu mengetahui spesifikasi
komputer yang dibutuhkan untuk menginstal Unity. Berikut spesifikasi
untuk menginstal Unity:



» Sistem operasi Windows XP SP2+, 7 SP1+, 8, 10 dan Mac OS§
10.8+. Tidak termasuk Windows Vista. Sedangkan pada Windows
dan OS X server belum dicoba.

» Kartu grafis yang mendukung Direct X 9 atau kartu grafis setelaly
2004. *

Setelah Anda mengetahui spesifikasi komputer yang dibutuhkan,
selanjutnya Anda akan menginstal Unity ke dalam komputer. Saat
penulisan buku ini, Unity terbaru adalah versi 5. Tetapi, dalam proses
penulisan buku ini menggunakan Unity versi 4. Unity versi 5 mengalam
perubahan dalam hal skrip pemrograman. Hal ini berarti Anda harus
menyesuaikan pemrograman dari skrip Unity versi sebelumnya. Pada
Unity versi 4 dan sebelumnya, Anda dapat menggunakan skrip
pemrograman yang sama.

Untuk meng-intall Unity, ikuti langkah-langkah berikut:
1. Buka situs Unity di alamat https:/unity3d.comy/.

2. Anda akan melihat tulisan Download Unity 5 sebagai shortcut
untuk men-download Unity 5 seperti Gambar 1.3. Untuk men-
download Unity versi 4, klik Get Unity.

 urity

CREATE AND CONNECT
WITH UNITY 5

Gambar 1.3 Tampilan halaman utama situs Unity

Untuk mendapatkan versi gratis, Anda pilih tab Indies & Studio.

4. Selanjutnya, Anda pilih kolom Personal.

GET UNITY

PERSONAL PROFESSIONAL
E

Gambar 1.4 Pilihan jenis Unity

Klik tombol Free Download di bagian bawah kolom untuk men-
download unity secara gratis.

m

Gambar 1.5 Klik Free Download

Selanjutnya, Anda akan dibawa ke halaman download installer.

Q) unity

SYSTEM REQUIREMENTS

DOWNLOAD UNITY

‘
==

RESOURCES

- A e (3] asenn s

O WRDOWS.

Gambar 1.6 Halaman download installer




7. Klik pada Resources > Older version of Unity.
Anda akan melihat pilihan versi Unity.

Pilih versi terbaru dari Unity versi 4 dan klik Download (Win) »
Unity Editor.
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UNITY 468 . W

UNITY 4.6.7

UNITY 4.6.6
UNITY 4.65
Gambar 1.7 Halaman awal proses instalasi

10. Tunggu hingga proses download selesai dan klik file installer.
11. Klik Next dan Anda akan dibawa ke halaman License Agreement.

€ Unity 4381 Setup - x
Licerme Agreement
Pesse renen the loess termm before natalng Uity <.6,811 Q

Prsd Page Down 20 see the test of the agresment,

[INFTT SOFTWARE LICENSE AGREEWENT VERSION 4.x j i .

[Summary of mpor Sant Use Restctons

;ﬂese Resd the Enwre Agreemsnt and Definstions Below

[Eniity Siw Heswaton for Uty Free

Uity Frie, which mcude the free platform sod on products, may not oe kcensed or
|uesd by 3 commetcls = bty wih sl groes revenuss hased on prior fecs ye) In

feveess of US3000,000, or by an educatorsd, academsc, nomerofit or goverrement entity
[ o mte arvial budget for the entire endity (based on pror flscal vear) In excess of
US£100,000 v

1F you acoept the terms of the agreenwmt, S0 | AQTES 1 Contrue, Tou must sccept the
agrewment tn instal Lrety A6 8F)

N o

Gambar 1.8 Halaman License Agreement

dan Anda akan diberikan pilihan komponen yang akan
. Jika Anda menginginkan contoh project Unity, Anda
mberi tanda pada semua pilihan.

“me.o.m Setup - X
Choowen Componerts
Lhooes which festures of Unity 4.6.5f1 you want 10 irstal Q |
|
Chedk the COMPONENts you ¥t I 115l andt LNCTHEIK e ComPOnents yix: o't want 1o
atall. Click Mext to conirue.
Select componeriis to install: -
[#] Example Project |
[#] Lnity Develooment Web Plaver
[J Monoleveiop
| Spece required: 5.9G0

oo [T |
Gambar 1.9 Memilih komponen untuk Unity

13, Klik Next dan Anda dapat memilih lokasi instalasi Unity.

9

Chocse Install Location
Choose the foider m wixch to mstal Uity 4.6.8F1, Q

Setup will ingtall Urity 4.6.671 In the foliowng foldes, To install i & different folder, dick
Browse and sslect another folder, Chok Inutall to start the mstatation

Destiration) Folder

| €:\program Fes (xB6)Linty Editor Browse. .,

Space requred: 6,968
Space avatable; 58,766

< Back Irstad Carxcel

Gambar 1.10 Memilih lokasi instalasi Unity



14. Klik Install dan proses instalasi akan berlangsung.

Q Unity 46811 Setup =
Installing
Please wait while Unity 4.6.8f1 is being nstallec

Instaling cocumentation,,

]

Hale et & Cancet

Gambar 1.11 Proses download komponen Unily

15. Tunggu proses download komponen yang diikuti proses instalasi
komponen Unity.

€ Unity 46.20) Setup =
Installing
Please wait while Unity 4.6.8¢1 s beng mnzalled. Q

Extract: NetworkConnectonErrer NoError it 100% A
Extract: NetworkConnectionErmor ASAPUbIcKe yMsmatch hitmd... 100%

Extract: NetworkConnectonEror, TooManyComectedPiayers himl, .. 100%

Extract: NetworkConnectionErron Minl .. 100%

Extract: NetworkDiscornection. Disconnected, ml., 100%

Extract: Networkfisconnection. LostConnecton.hitml, ., 100%

Extract: NetworkDisconnection.html, .. 100%

Extract: Networkloglevel Full ntid, ., 100%

Extract: NetworkLoglLevel Informationa hind. .. 100%

Extract: NetworkLogLevel Off himl... 100% "

Gambar 1.12 Proses instalasi unity dimulai

Instalasi juga akan menginstal komponen tambahan dalam

€@ Unity 4630 Setup

Tvst alling
Plesse wait whie Unity 4.6.0f1 i being rstsiing
Irstaling plavback engines
1 Extroct: ambience rsde slecing 3owav meta.. . 100% ~

Extract: ambience_rade_fan wav,., 100%
Extract: amblence_rads_fan wav meta. . 100%
Sxtract amblence_rsde hum way. . 100%
Extract: ambience_nsde_hum, wav. meta. .. 100%
Extract: ambience _rmde_noise. wav... 100%
Exwact amblence_rade_nowe, wav meta, ., (00%

Extract: amblence_rsde _steam _ 100%

Exvacy: aminerce nsde stear mets,.. 100%

Extract: smtvence_rede steam 2 v
= Sty et L

Gambar 1.13 Proses download komponen lain dari Unity

7. Setelah proses intstalasi selesai, Anda akan melihat halaman seperti
Gambar 1.14. Klik Finish untuk menyelesaikan proses instalasi.
Anda dapat memberi tanda pada Run Unity jika ingin langsung
menggunakan Unity.

€@ Unity 4581 Setup -

Completing the Unity 4 6.811 Setup

Ity 4.6.511 has been netalied on your computer

Ok Figh: 1o choge Setup

EArun Uty 4.8.801

unity

Gambar 1.14 Proses instalasi selesai



1.4  Menggunakan Unity

Setelah terpasang di komputer, Anda dapat langsung mengguna
Unity. Pada pembahasan ini Anda akan dikenalkan dasar-da
menggunakan Unity termasuk pengenalan lempar kerja dari Unity.

Untuk menggunakan Unity, ikuti langkah-langkah berikut:

ws | irewadlll has blocked some fe

Windaws Frewall hac blocked some featares of Urity Edtor on l puble and privarte retworks

Q Mot mEm
Pubisher Unity Techrologes ApS
Path. Cprogram files \urity \pettor \urity eve

Klow Uity Editzy o commurcate on thess swiveris:
[CIPrivate retsorks, such as my home o wark netwers

[ e nemnorks, such as thase 1 mrports and (afés (ot recommended
Decmise theee ntworks often haue Htie or 1o seanty)

st ey e tighe of sléwing an o0 trac o frenal

Ao scosss Cancel

Gambar 1.15 Membubka firewall

1. Klik ikon Unity. Terkadang Anda harus membuka blok dari firewall
supaya Unity dapat digunakan seperti Gambar 1.15.

2. Seblum Anda menggunakan Unity, Anda akan diminta memilih tipe
akun Unity. Untuk menggunakan Unity secara gratis, klik Unity
Personal Edition.

LT ——
Qumy ®

Activate your license

Lty Profacsions Eatlor

Gambar 1.16 Memilih tipe akun Unity

Next.

Ploase solect one of the options below
The company or orgamizaaon | represent sarmed more than
$100.000 11 gross raveritie (11 5% Drevious fscal year

The company o organization | rapresent sarmed less than
F100.000 In gross revanus 1N Ne previous Nscal year

| dord't use Linity In 2 profeesional capacity

Gambar 1.17 Memilih tujuan penggunaan Unity

Selanjutnya, Anda akan diminta untuk memasukkan akun Unity.

@ Uty - Actvat
Qunity @

Log into your Unity Account

Eme

15
| i Keep up-mo-0ate shout Unty news, des's, events, games and inargl | agree o the
¥ Unity Privacy Solicy and e processing and use of my ofarmaban
m

(0] VUL Ras @

Gambar 1.18 Login akun Unity

ya, Anda akan diberikan pilihan tujuan penggunaan Unity.
1 paling bawah supaya dapat menggunakan unity secara



5. Jika Anda tidak memiliki akun Unity, klik Create account

kt dan akan muncul License Agreement.
Kemudian Anda akan diantar ke situs pembuatan akun Unity.

l
Create a Unity Account

(remame

Gambar 1.21 Tampilan License Agreement

Country

Password

Selanjutnya, Anda dapat memilih membuat project baru atau
menampilkan project lama.

Gambar 1.19 Mengisi data

Unity - Prosect Wazard (4.6.801) X

Qoen Propct  Creste New Promct

6. Setelah mengisi data, klik Create Account untuk menyelesaikan
proses pembuatan akun Unity. Akun ini digunakan untuk aktivasi
Unity dan men-download Asset dari Unity. Asset dapat digunakan
untuk melengkapi bahan-bahan pembuat game yang telah

Select recently opmned progect:

|

disediakan Unity.
7. Masukkan username dan password Anda untuk login ke dalam
Unity. ‘
8. Selanjutnya, Anda akan melihat halaman seperti Gambar 1.20. P - ‘
& Uity - Activation %
Q unity . . . ® Gambar 1.22 Membuat project baru

Thank you for activating Unity! I'l. Klik New Project untuk membuat project baru.

12. Selanjutnya, Anda dapat memberi nama projek, memilih tempat
menyimpan projek, dan memilih asset yang akan digunakan. Jika

Anda tidak ingin menggunakan asset, Anda tidak perlu klik bagian
asset. Asset ini dapat ditambahkan saat Anda sedang membuat

Gambar 1.20 Memilih versi Unity projek.
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Unity - Project Weard (4.6811)

Open Project  Crestes New Project

Project Location

an bagian untuk mengatur pembuatan game secara

C:\Jp;n\ad‘dy\'.}onmsvarw Uity Project

| i .‘.'Pada menu terdapat kategori berikut:

i I * ligunakan untuk membuat project baru, menyimpan, load, dan
| ] Character Controller unityFackage A sl project.

[C] ught Cookies.unmtyPackage -

P]m S i eniers : Digunakan untuk mengedit project yang sedang Anda kerjakan.

_| Particles. unityPaciage

g:::d::";;:‘j‘::’* Digunakan untuk import dan export asset.

- sall me Object. Digunakan untuk membuat objek pada Unity.
Sewp defos or: (B0

pmponent. Digunakan untuk menambahkan komponen pada

Gambar 1.23 Pengaturan praject . Digunakan untuk mengatur tampilan jendela pada lembar

13. Klik Create Project untuk loading data project dan asset yang Anda Jelp. Digunakan untuk mengetahui manual dari Unity.
pilih.
14. Anda akan masuk ke dalam lembar kerja Unity.

File Edit Assets GameObject Component Window Help

Gambar 1.25 Tampilan menu Unity

1.4.2 Shortcut

Shortcut merupakan bagian dari Unity yang digunakan untuk

memudahkan Anda dalam membuat project. Shortcut merupakan jalan
singkat dari beberapa pilihan menu.

Jika Anda lihat pada lembar kerja Unity, pada bagian shortcut terdiri dari
liga bagian, yaitu kiri, tengah, dan kanan. Pada bagian kiri, Anda dapat

menggunakan shortcut untuk pengaturan objek pada jendela Scene.
Shortcut tersebut sebagai berikut:

» Gambar tangan. Digunakan untuk menggeser tampilan layar project.

Gambar 1.24 Tampilan lembar kerja Unity

Setelah Anda membuka Unity, Anda perlu mengenal lembar kerja dari

Unity. Secara umum, lembar kerja Unity dibagi menjadi menu, shortcut,
dan jendela lembar kerja.



skala. Digunakan untuk mengubah ukuran skala objek
an koordinat x, y, dan z.

Gambar 1.26 Menggunakan shortcul gambar langan

» Shortcut arah. Digunakan untuk menggeser objek berdasarkan
koordinat sumbu x, y, dan z.

Gambar 1.29 Menggunakan shortcut skala

cut skala horizontal. Digunakan untuk mengubah ukuran
bjek sisi horizontal.

Gambar 1.27 Menggunakan shortcut menggeser objek

» Shortcut rotasi. Digunakan untuk memutar objek berdasarkan
koordinat sumbu x, y, dan z.

Gambar 1.30 Menggunakan shortcut scala horizontal

Pada bagian tengah terdapat tombol untuk menjalankan dan
menghentikan game. Tombol ini digunakan untuk menguji berjalannya
game pada jendela Game sebelum game dikompilasi menjadi stand
alone.

Gambar 1.28 Menggunakan shortcut memutar objek
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Scene/Game: Jendela Scene menampilkan seluruh onjek
digunakan dalam game. Jendela Game digunakan untuk
kan objek yang telah diletakkan pada jendela Scene.

Gambar 1.31 Menu shortcut menjalankan game
Gambar 1.34 Jendela Scene/Game

Pada bagian kanan terdapat Layer, Layout, dan Account. Layer
digunakan untuk mengatur tampilan layer pada jendela Scene. Layout
digunakan untuk mengatur susunan layout jendela kerja. Account
digunakan untuk login dan logout akun Unity.

ela Project/Console: Jendela Project menampilkan semua asset

g Anda import pada project. Jendela Console digunakan untuk

ngetahui bagian yang error/bermasalah saat game akan dijalankan
un).

Layers  « [ Default - Account =

Gambar 1.32 Shortcut pengaturan Layer, Layoul, dan Account

1.4.3 Jendela Lembar Kerja
Secara default, jendela lembar kerja dibagi menjadi empat bagian seperti
berikut:

» Hierarchy: Jendela yang menampilkan daftar objek yang ada di
jendela Scene. Gambar 1.35 Jendela Project

Gambar 1.33 Jendela Hierarchy Gambar 1.36 Jendela Console
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» Jendela Inspector: Digunakan untuk mengatur asset yan . proses compile game menjadi mobile dalam platform

dimasukkan ke dalam layer Scene. dengan proses compile untuk platform lainnya. Anda perlu
perintah yang menggunakan touchscreen untuk
karakter. Selain itu, pada proses compile Anda akan
menginstal software development kit dari perangkan
Android, Anda akan diminta menginstal SDK.
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Gambar 1.37 Jendela Inspect Gambar 1.38 Game Drift Mania Championship

1.5 Unity dengan Game Android Siteunshors

Dalam proses pembuatan game dengan game engine, pada tahap akhir
tentu Anda akan meng-compile game tersebut supaya dapat dimainkan
orang tanpa harus membuka Unity terlebih dahulu. Unity memberikan
beberapa pilihan compile kepada Anda. Anda dapat meng-compile
game menjadi platform PC, mobile, konsol, atau web.

Pada pilihan mobile, Anda dapat meng-compile untuk platform Android,
Windows Phone, iPhone, dan Blackberry. Jika Anda pengguna Android,
Anda dapat menemukan beberapa game yang dibuat menggunakan
Unity. Ciri khas dari game yang dibuat dengan Unity baisanya pada awal
game ditampilkan logo Unity, meskipun logo ini dapat dihilangkan jika
Anda menggunakan Unity versi berbayar. Gambar 1.39 Game Ragna Rock

1. 1 Es your job 10 clean ot the sstrrol
i i itte to the orignal Clas Latle garme
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) RANCANGAN AWAL GAME
"] SURVIVAL

Intuk membantu Anda dalam menguasai Unity, pada buku ini Anda
kan dijelaskan cara membuat game survival. Sebelum Anda mulai
buat game, Anda akan membuat rancangan awal dari game
but. Tujuan pembuatan rancangan awal supaya Anda mendapatkan
gambaran dari game yang akan Anda buat.

2.1 Mengenal Game Survival

Survival secara sederhana dapat diartikan bertahan hidup. Pada game
survival, Anda akan mengendalikan karakter untuk bertahan hidup
menghadapi berbagai rintangan hingga tujuan yang ditetapkan oleh
game tercapai.

Pada pembuatan game survival kali ini Anda akan menempatkan
karakter di dalam sebuah peta. Karakter diharuskan mengalahkan
berbagai musuh untuk mencapai tujuan yang ditetapkan oleh game.
Selain itu, dalam game, sudut pandang yang digunakan adalah sudut
pandang orang pertama. Jadi Anda tidak akan melihat bentuk karakter,
tetapi hanya tampilan pemandangan game dan senjata yang digunakan
untuk mengalahkan musuh.

Pada bab ini, Anda akan membuat rancangan dari game survival terlebih
dahulu. Anda akan dijelaskan cara membuat peta yang akan dijadikan
tempat karakter bertualang serta cara karakter dapat mengalahkan
musuh yang menghadang.



2.2 Membuat Peta dan Menguji Pergerakan
Karakter

O T T ——
' B‘FEEST""_“"_""" Lstatic ~
ch l Unbuggd

Pada awal perancangan game, Anda akan mencoba membuat peta
sederhana sebagai tempat bergeraknya karakter.*Selanjutnya, Anda juga
akan menambahkan karater dari asset bawaan Unity untuk mencoba
pergerakan karakter di dalam peta. Untuk lebih jelas, ikuti langkah-
langkah berikut:

1. Buka program Unity.
2. Klik GameObject > 3D Object > Cube.

menjadi “50",

GemeObject Component Window  Help

Creats Empty Ctrle Shifte N [ O Inspector
Creste (mpl, Child Alte Shifre iy N Cub.\ i ] [Static =
. 00hject mEEE T Tag [Untagged ¢ ) Layer |Defauit &)
20 Obiject ) Sphere Y A dewm [WE-%
Lt b Copuke @m{‘”‘*"' L2 o el ]
Audio 5 Cylindes Rmﬂ x 0 z,a:.._—..
Ul ’ Plane :
Particle System Quad 1 s“'. % xv }\w‘p : >§ —i

Gambar 2.1 Klik GameObject > 3D Object > Cube

3. Anda akan melihat betuk kubus di jendela Scene.

Gambar 2.4 Mengubah nilai x menjadi 50

7. Selanjutnya, ubah nilai z menjadi “50".

sama sisi.

Gambar 2.2 Tampilan kubus di jendela Scene

4. Pastikan posisi kubus berada di tengah layar dengan cara ubah nilai
X, y, dan z menjadi “0" pada jendela Inspection bagian Position.

24

Gambar 2.3 Mengatur posisi x, y, dan z menjadi 0

Anda akan melihat bentuk kubus menjadi lebih panjang.

Masih pada jendela Inspector. Pada bagian Scale ubah nilai x

B, Anda akan melihat bentuk object menjadi kotak persegi empat
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9.

Gambar 2.7 Mengubah nama object

Selanjutnya, Anda akan menambahkan asset karakter ke dalam
Inity. Asset ini digunakan untuk menguji pergerakan karakter pada

. Untuk melakukannya, Klik kanan pada jendela Project
Semudian pilih Import Package > Character seperti Gambar 2.8. '

Anda akan melihat daftar asset dari karakte
Clik Import. r seperti Gambar 2.9.

Gambar 2.5 Bentuk object menjadi segi empal
Deiet
Jika Anda melihat bentuk object terlalu besar, Anda dapat zoom ‘
jendela Scene dengan scroll mouse. Gunakan tool tangan untuk Cyisponlfsions
menggeser sudut pandang dan klik kanan untuk menggeser v Ribreneas Jo Seii z"
andangan secara vertikal. Select Dependencies b
pardanga Secard s 5 B
resh CuleR CrossPlatforminput
Reimpont Effects
Resmport All Ervironment
Russ AP Updates PasticleSystems
Prototyping
Sync MonoDevelop Project Urility
Vehicles

Gambar 2.8 Klik Import Package > Character

Gambar 2.6 Mengubah sudut pandang tampilan peta

10. Pada jendela Hierarchy ubah nama object “Cube” menjadi
“GroundPlane". Caranya, klik kanan nama object Cube dan pilil

Rename. Pilih nama baru menjadi “GroundPlane”.

26
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13. Jika Anda melakukannya dengan benar, Anda akan melihat assel

14.
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Gambar 2.9 Daftar asset karakter

baru pada jendela Project.
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Gambar 2.10 Menambahkan asset karakter

Selanjutnya, masukkan karakter ke dalam jendela Scene. Caranya
pada asset buka folder Asset > Standart Assets > Chara.ters >
First Person Controller > Prefabs. Klik objek dan drag ke jendela
Scene.

Gambar 2.11 Menambahkan karakter pada jendela Scene

Selanjutnya, pada jendela Hierarchy klik object First Character

Controller yang merupakan object karakter. Anda akan melihat
komponen Main Camera.

~ Main Camera
roundPlane

Gambar 2.12 Klik object untuk menampilkan komponen Camera

Pada jendela Inspector dari object Main Camera, Klik Add
Component dan ketikkan Skybox.

Anda akan melihat komponen Skybox. Klik komponen sehingga
komponen ditambahkan dalam jendela Inspector.
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Search

asset yang “free” untuk mendapatkan asset gratis.

Klik Open in Unity untuk membuka aset di Unity. Anda akan dipilih
Atuk membuka asset di Unity Editor.

at asset ditampilkan di Unity Editor, klik Download.

nggu proses download. Anda akan melihat asset siap untuk
dimasukkan ke dalam Unity dengan cara klik Import.

Woweome W D IRV BT T L T e R A R
BAS. 3.~

| SN

Wispy Skybox

Gambar 2.16 Unity Editor
Gambar 2.14 Komponen Skybox berhasil ditambahkan
Kembali pada jendela Inspector dari Camera. Pada bagianSkybox

18. Masukkan asset skybox dengan klik kanan pada jendela Project klik pada tanda bulat untuk menampilkan pilihan skybox.

Kemudian pilih Import Assets > Skybox.

Search Results

Gambar 2.15 Pencarian asset skybox

19. Jika Anda tidak punya asset skybox, Anda dapat men-downloadnys
di assetstore Unity di https:/www.assetstore.unity3d.com/en/. Ketil Gambar 2.17 Memilih skybox
“Skybox" pada kolom pencarian seperti Gambar 2. 15.
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25. Jika Anda lihat pada jendela Game, Anda akan melihat tampila

langit berubah. menghentikan game klik kembali tombol Play.

Anda akan membuat tembok. Caranya, klik

Gambar 2.18 Mengubah tampilan langit

26. Jika jendela Scene terlihat gelap, tambahkan cahaya dengan Kklik
GameObject > Light > Directional Light.

27. Jalankan game dengan buka jendela Game dan klik tombol Play.

28. Gerakkan karakter dengan tombol arah, loncat dengan Space, dan
berputar dengan mouse. Gambar 2.21 Menambahkan objek kubus

Buat objek kubus menjadi pipih dengan mengganti nilai x dengan
"10" dan y dengan “5" pada jendela Inspector bagian Scale.

* Tme

Gambar 2.19 Menjalankan karakter

29. Jika karakter bergerak melebihi peta, karakter akan jatuh.

Gambar 2.22 Mengubah kubus menjadi pipih

M. Pastikan objek dinding menyentuh tanah. Jika objek dinding masih
terlihat melayang, gunakan tool shortcut arah atau mengubah nilai
y pada jendela Inspector bagian Position.

A8, Selanjutnya, ubah nama objek tembok menjadi “HouseWall1".

Gambar 2.20 Karakter jatuh dari peta
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36. Perbanyak objek tembok dua kali dan ubah namanya menjadi
“HouseWall2" dan "HouseWall3". Caranya klik kanan objek
HouseWalll dan pilih Duplicate.

mbar 2.25 Melihat bentuk tembok dari sudut pandang karakter

Gambar 2.23 Objek tembok diperbanyak
Menambahkan Musuh dan Sistem

37. Ketiga objek tembok saat ini saling bertumpukan menjadi satu. Membunuh Musuh

Oleh karena itu, Anda perlu menggeser dua objek tembok
menggunakan tool shortcut arah dan rotasi untuk membentuk

posisi seperti Gambar 2.24. n sebuah game survival, untuk meningkatkan tantangan Anda

I menambahkan musuh. Selain menambahkan musuh, Anda juga
| akan memikirkan cara membunuh musuh tersebut. Pada
bahasan ini, Anda akan membuat musuh dan membunuh musuh
Untuk lebih jelas, ikuti langkah-langkah berikut:

Clanti nama objek First Person Controller menjadi “Player”.

Jika objek Player Anda tidak memiliki tampilan, buat tampilan
dengan cara klik kanan pada objek Player di jendela Hierarchy.
"\«. udian pilih 3D Object > Capsule. Ubah nama objek menjadi
“Ciraphic” seperti Gambar 2.26.

L

ierarch
Gambar 2.24 Mengubah posisi tembok JREAPETTY

38. Jalankan kembali karakter untuk melihat hasil posisi tembok darl
sudut pandang karakter.

Gambar 2.26 Menambahkan bentuk pada objek karakter
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3. Buat objek baru dengan klik GameObject > Create Empty.
4. Anda akan melihat objek baru yang tidak memiliki bentuk.

Gambar 2.29 Posisi objek kosong di dalam objek karakter

Pada jendela Hierarchy, drag objek Melee ke dalam objek Player
sehingga objek Melee menjadi child dari objek Player. Hal ini akan
membuat objek Melee bergerak mengikuti pergerakan objek Player.

L |

Gambar 2.30 Membuat objek Melee child dari objek Player

Pastikan pada jendela inspector bagian Rotation dari objek Player
sumbu x, y, dan z adalah 0.

Gambar 2.28 Tampilan bentuk objek karakter

Geser posisi objek Melee agak ke kanan dari objek Player dan buat

5. Beri nama objek tersebut dengan “Melee”. Objek ini digunakan
Rotaion objek menjadi 0 pada sumbu x, y, dan z.

sebagai pengaturan supaya karakter dapat menyerang musuh.

6. Pindahkan objek sehingga ada di depan objek karakter. Untuk
memudahkan, Anda dapat menyalin posisi objek Player ke posisl
objek Melee yang ada di jendela Inspector bagian Position dan
geser posisi ke depan objek karakter.

Gambar 2.31 Menggeser posisi objek Melee
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. Pada jendela inspector dari objek Melee, klik Add Component dan
ketik “Script” kemudian pilih New Script.

11. Isi nama skrip dengan “MeleeSystem” dan pilih bahasa ¢ .
pemrograman dengan Javascript. @ voleesysom + (I Avabe
! Assenibly-CSharp firstpass

fuaazizn Graws () (

* tunction Update () I
"

Gambar 2.34 Tampilan skrip objek Melee
Hapus baris 3 sampai 9 dan buat variabel baru seperti berikut:

#pragma strict

. var Damage: int = 50;
- var Distance : float;

Jerdasarkan skrip di atas, Anda menambahkan variabel Damage
 Distance. Variabel Damage digunakan untuk membuat
sakan kepada musuh. Pada skrip di atas senjata karakter akan
berikan kerusakan sebesar 50 untuk setiap serangan. Pada
variabel Distance digunakan untuk menentukan jarak serangan.
“loat digunakan supaya jarak dapat ditentukan dalam desimal.

Gambar 2.32 Membuat skrip program

12. Anda akan melihat komponen baru dari objek Melee.

selanjutnya, Anda akan membuat serangan karakter dapat
mengenai musuh dengan mengetikkan skrip berikut:
function Update ()
if (Input.GetButtonDown ("Firel"})
var hit : RaycastHit;
if (Physics.Raycast (transform.position,
transform.TransformDirection (Vector3. forward), hit))

Distance = hit.distance;

hit.transform.SendMessage ("ApplyDammage", Damage,
SendMessageOptions.DontRequireReceiver) ;

!

Gambar 2.33 Skrip dari objek Melee

13. Pada jendela Project, klik skrip MeleeSystem untuk menampilkan : )
aplikasi menulis skrip.

an skrip di atas, Anda membuat perintah menembak
tombol mouse (Firel). Selain itu, Anda juga membuat
dilakukan ke arah depan atau arah karakter. Variabel
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Distance akan menunjukkan jarak serangan yang dilakukan. Jaral

ini akan berkurang jika karakter semakin mendekati objek yang
menghalangi serangan.

“*
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Gambar 2.35 Skrip lengkap dari MeleeSystem

16. Jika Anda lihat pada jendela Inspector dari objek Melee, Anda akar
melihat komponen baru yang berisi Damage dan Distance.
Komponen Damage akan bernilai tetap, sedangkan komponen

Distance akan berubah tergantung jarak karakter dengan objek
penghalang.

Gambar 2.37 Perubahan nilai Distance

llka karakter Anda mendadak tidak dapat digerakkan buka bagian
a Inspector objek Graphic. Kemudian klik tanda gear pada
e Collider dan pilih Remove Component.

Gambar 2.36 Tampilan komponen Damage dan Distance

17. Jika Anda jalankan dan Anda klik kiri, nilai Distance akan berubah
sesuai jarak karakter dengan objek penghalang.

Gambar 2.38 Komponen objek Graphic
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19.

20.

21.

Saat ini Anda telah membuat karakter yang dapat menyerang
musuh, akan tetapi serangan tersebut tidak memiliki batasan. Oleh
karena itu, Anda akan membuat batas maksimal jarak serangan.
Hal ini bertujuan supaya karakter dapat membunuh musuh dari
jarak tertentu saja. Caranya, tambahkan variabel baru pada
MeleeSystem.

var Damage : int = 50;
var Distance : float;
var MaxDistance : float = 1.5;

Berdasarkan skrip di atas, Anda menambahkan variabel

MaxDistance yang digunakan untuk menentukan masksimal jarak
serangan, yaitu 1,5.

Selanjutnya, pada bagian fungsi Update buat menjadi seperti
berikut.

function Update ()
if (Input.GetButtonDown("Firel"))

var hit : RaycastHit;
if (Physics.Raycast (transform.position,
transform.TransformDirection(Vector3.forward), hit))

Distance = hit.distance;
if (Distance < MaxDistance);

hit.transform.SendMessage ("ApplyDammage", Damage,
sendMessageOptions.DontRequireReceiver) ;

}
}
}

Berdasarkan skrip di atas, Anda menambahkan rumus Distance
kurang dari MaxDistance. Hal ini berarti serangan akan berhasil jika
variabel Distance nilainya lebih kecil dari MaxDistance.

Jika Anda lihat pada jendela Inspector dari objek Melee, Anda akan
melihat komponen variabel baru, yaitu MaxDistance.

Gambar 2.39 Variabel baru pada objek Melee

). Sekarang Anda akan membuat objek musuh. Caranya klik

CreateObject > 3D Object > Capsule.

. Tempatkan objek musuh di tempat yang Anda inginkan dan beri
nama “Enemy”.

. Pada jendela Inspector objek Enemy tambahkan komponen skrip
dengan nama “Enemylogic”.

Gambar 2.40 Tampilan objek musuh




26.

27.

Selanjutnya, hapus skrip default dan tambahkan variabel baru

seperti berikut: lik tombol Play untuk menguji game. Jika Anda menembakkan

n usuh dari jarak jauh, tidak ada pengaruh pada musuh. Sebaliknya
/.\nda menembak musuh dari jarak kurang dari variabel
\axDistance, nyawa musuh akan berkurang. Jika nyawa musuh

ampai 0, maka objek musuh akan menghilang.

var Health = 100;

Variabel di atas sebagai nyawa dari musult dengan jumlah 100. Jika
Anda lihat kembali variabel Damage, Anda telah menentukan
variabel dengan nilai 50. Artinya, untuk membunuh musuh perlu
dua kali serangan.

Selanjutnya, buat fungsi untuk menentukan persyaratan musuh
mati.

function Update ()
if (Health <= 0)

Dead() ;
}
}

function ApplyDammage (Damage : int)

bar 2.41 Pada jarak jauh, serangan tidak mepengaruhi nyawa

Health -= Damage; musuh

}

function Dead ()

Destroy (gameObject);

}

Pada fungsi Update menjelaskan yang terjadi jika nyawa objek
kurang dari sama dengan 0, yaitu memunculkan fungsi Dead yang
berarti mati. Akan tetapi, fungsi Dead belum dikenali oleh Unity.

Pada fungsi ApplyDammag akan  memanggil  fungsl
ApplyDammage yang ada di skrip objek Player. Fungsi ini akan
menghitung pengurangan nyawa objek Enemy saat terkena
serangan karakter dari jarak tertentu, yaitu saat variabel Distance
kurang dari variabel MaxDistance.

Pada fungsi Dead akan menjelaskan yang terjadi pada objek Enemy
saat dinyatakan mati, yaitu objek akan menghilang. Hal ini
dijelaskan dari fungsi Destroy (gameObject). Fungsi ini juga
menjelaskan fungsi Dead yang ditampilkan pada fungsi update.

Kembali pada Unity. Jika Anda lihat jendela Inspector dari objek
Enemy, Anda akan melihat sekarang objek memiliki nyawa
Komponen nyawa akan berkurang saat terkena serangan darl
karakter.

bar 2.42 Pada jarak dekal, serangan mengurangi nyawa musuh
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Gambar 2.43 Saat nyawa musuh 0, objek musuh menghilang

2.4 Membuat Animasi Senjata

Untuk membuat serangan karakter menjadi terlihat, Anda akan
menambahkan senjata sebagai alat untuk membunuh musuh. Senjata
ini akan bergerak dan akan mengurangi nyawa musuh jika senjata
mengenai musuh. Untuk menggerakkan musuh, Anda akan
membutuhkan animasi. Untuk lebih jelas, ikuti langkah-langkah berikut:

1.  Untuk memudahkan membuat senjata pisahkan jendela Game dan
Scene dengan cara drag pada nama “Game” sehingga dapat
diletakkan di sebelah jendela Scene.

tasn qm“‘mq

Gambar 2.44 Memishakan jendela Game dan Scene

‘ tot?jek baru dengan klik GameObject > 3D Object > Sphere.
emudian pindahkan objek mendekati objek Player.

Gambar 2.45 Meletakkan objek baru di dekat objek Player

Buat lagi objek baru dengan pili
pilih GameObject > 3D Object >
Cylinder. Letakkan objek di bawah objek bola. :

Gambar 2.46 Meletakkan objek silinder di bawah objek bola

Atur slfala dan posisi dari objek bola dan silinder sehingga
proporsional dengan objek Player.
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Gambar 2.47 Mengatur ukuran dan posisi objek

Pada jendela Hierarchy, drag objek silinder sehingga menjadi child
dari objek bola.

Ubah nama objek bola menjadi “Mace” dan objek silinder menjadi
“Grip".

Gambar 2.48 Menyatukan objek bola dan silinder

Letakkan objek Mace di depan karakter agak ke kanan sehingga
memiliki tampilan di jendela Game seperti Gambar 2.49.

Gambar 2.49 Meletakkan objek Mace dekat karakter

bupaya objek Mace selalu mengikuti karakter, jadikan objek Mace
hild dari objek MainCamera yang ada di dalam objek Player.

Gambar 2.50 Membuat objek Mace child dari objek MainCamera
1

Hilangkan Sphere Collider dari jendela Inspector objek Mace dan
Cylinder Collider dari jendela Inspector objek Grip.

Kli objek Mace. Kemudian klik Window > Animation. Drag
Jendela tersebut sehingga ada di sebelah jendela Project dan
Console.

Gambar 2.51 Menampilkan jendela Animation



11. Klik Create pada jendela Animation sehingga dimunculkan kota

dialog untuk menyimpan animasi. Beri nama animasi dengg
“Attack” dan klik Save untuk menutup kotak dialog.

'!"V""" Y LY SO T e
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Gambar 2.52 Tampilan jendela Animation

12. Selanjutnya, klik Add Property > Transform dan pilih semua
komponen Transform, yaitu Position, Rotaion, dan Scale.

| Dopu y

Gambar 2.54 Posisi awal senjata

Posisi senjata saat menekan mouse akan seperti Gambar 2.55.
Posisi ini dibuat pada titik detik ke 10.

il Gambar 2.53 Menambahkan objek senjata dalam jendela Animation

l ) 13. Posisi objek Mace pada titik 0 seperti pada Gambar 2.54.

|l | A

; J “

| Gambar 2.55 Posisi senjata saal menekan mouse
| ‘J
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tombol Play untuk mencoba menjalankan animasi dan klik
bol merah bulat IT atau Ctrl+$ untuk menyimpan animasi.

a kembali jendela Project dan klik Attack.

wwww

Gambar 2.56 Pengaturan posisi senjata

15. Setelah mouse dilepas, senjata akan kembali ke posisi semula.

Gambar 2.59 Klik animasi Attack

da jendela Hierarchy klik tombol kanan atas dan pilih Debug.

‘

Gambar 2.57 Posisi senjata kembali

Gambar 2.60 Memilih mode Debug
ada Unity 5, pada bagian Legacy beri tanda untuk membuat

limasi dalam mode Legacy. Pada Unity versi lama ketik 1 pada
inimation Type.

Gambar 2.58 Pengaturan posisi senjata kembali ke posisi semula




if (Distance < MaxDistance)

| hit.transform.SendMessage ("ApplyDammage", Dama
-BendMessageOptions.DontRequireReceivgif: sk E

}

! }

}

agian yang ditebalkan adalah perintah untuk menjalankan animasi
tack. Perintah ini berlaku untuk Unity versi lama. Sedangkan pada

ity versi 5, Anda dapat mengetikkan: GetComponent
Animation > ().Play(“Attack”);.

Gambar 2.61 Membuat animasi dalam mode Legacy

20. Drag objek Mace pada kemdela Hierarchy ke objek Mel
sehingga sekarang objek Mace menjadi child dari objek Melee.

490, trensfors. TlansfossSfrmsbial i Yoctery, forvesdl  mst

1 IrER e e Deedieesace [ ArmlLasa gt t, Danege, Jeniesssgecpuscay, Simt Kaged rebesasver) |

Gambar 2.63 Skrip lengkap MeleeSystem

objek Mace dan tambahkan komponen Animation. Pada
gian Animation tambahkan animasi Attack.

Gambar 2.62 Membuat objek Mace menjadi child dari Objek Melee !

21. Buka kembali skrip MeleeSystem. Tmabakan variabel “Mace”.

Transform;

var Mace :

22. Selanjutnya tambahkan animasi Attack ke dalam skrip sepe
berikut:

function Update ()

if (Input.GetButtonDown("Firel"))
{ Gambar 2.64 Memasukkan animasi Attack ke objek Mace

Mace.animation.Play ("Attack");

var hit : RaycastHit;

if (Physics.Raycast (transform.position,
transform.TransformDirection(Vector3.forward), hit))

Ik objek Melee. Anda akan melihat komponen Mace. Pilih Mace
’ komponen,

Distance = hit.distance; )
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Klik tomb

tombol mouse, senjata akan bergerak. Jika Anda menyera
musuh dengan jarak yang kurang dari variable MaxDistance, nya
musuh akan berkurang dan akan menghilang saat nyawa mus

menjadi 0.

MEMPERBAIKI TAMPILAN

FETA

Gambar 2.65 Menambahkan pilihan Mace

ol Play untuk menguji game. Ketika Anda menek

I

I Anda tentu telah mendapat gambaran game yang akan dibuat
uku ini. Untuk mengembangkan rancangan dasar dari game,
i pertama yang akan Anda buat adalah peta. Pada bab
mnya peta hanya berbentuk segi empat dan karakter dapat
h dari peta. Pada bab ini Anda akan memperbaiki tampilan peta
ga menjadi lebih menarik dan ada pembatas yang membuat
ef tidak dapat terjatuh dari peta.

Gambar 2.66 Menguji game

Membuat Efek Kabut

pembahasan ini Anda akan menambahkan efek kabut pada peta.
inya, sebagai pambatas jarak pandang karakter sekaligus untuk
) efek misteri pada game yang dapat menjadi nilai tambah
Suatu game survival. Untuk melakukannya, ikuti langkah-langkah

lik Edit > RenderSetting. Pada Unity versi 5 menu ini ada di
findows > Lightning.
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Gambar 3.3 Efek kabut dalam game

Mengganti Bentuk Peta

Progect Settings > saat membuat rancangan game, Anda membuat peta dengan
Render Settings junakan objek. Pada pengembangan game ini Anda akan
jJanti peta tersebut dengan Terrain. Terrain merupakan objek yang
khusus untuk membuat peta. Untuk lebih jelas, ikuti langkah-

“@berikut:
lapus objek GroundPlane yang sebelumnya digunakan sebagai

elanjutnya, Klik GameObject > 3D Object > Terrain.
nda akan melihat objek Terrain di jendela Hierarchy.

Gambar 3.1 Klik Edit > Render Setting

2. Lihat pada bagian Fog. Anda akan melihat pengaturan tampi
efek kabut.

Gambar 3.2 Pengaturan Fog

Beri tanda pada Fog seperti Gambar 3.2 untuk menampilkan e
kabut.

4. Pada bagian Fog Color biarkan bewarna abu-abu unis
menyesuaikan dengan kondisi kabut yang sebenarnya.

5. Density merupakan tingkat ketebalan kabut. Pada Gambar 3.2 dil
dengan “0.1" supaya kabut tidak terlalu tebal.

6. Jika Anda klik tombol Play, Anda akan melihat efek kabut terll
dalam game.

Gambar 3.4 Objek Terrain pada jendela Hierarchy




4. Jika Anda lihat pada jendela Scene, Anda akan melihat peta yang
lebih besar dari sebelumnya.

at pada bagian Resolution. Atur pangjang, lebar, dan tinggi
frain seperti Gambar 3.8. Tinggi terrain digunakan untuk
embatasi ketinggian objek yang dibuat pada terrain.

Gambar 3.8 Pengaturan panjang, lebar, dan tinggi terrain

. h

ambar 3.5 Tampilan Terrain dengan objek karakter di kiri bawa .
e ka Anda lihat pada jendela Scene, Anda melihat objek Player
rada terlalu ke kiri bawah. Oleh karena itu, Anda perlu menggeser

sehingga objek Player ada di tengah. Gunakan tool Position
au mengubah Position pada jendela Inspector.

5. Klik objek Terrain untuk memunculkan pengaturan pada jende
Inspector. Jika kondisi jendela Inspector masih dalam keadaa
debug, klik pada ikon gear dan pilih Normal.

Manimize
Clese Tab

Add Tab 4

Gambar 3.6 Memilih mode Normal

6. Pada bagian Terrain klik ikon plaing kanan untuk menampilka
pengaturan terrain.

' ¥ i M Terrain

ol

Gambar 3.7 Klik ikon Terrain Setting

T Terrain Settings

Gambar 3.9 Objek Player berada di tengah terrain

htuk membuat pola pada peta, Anda perlu menambahkan gambar

la bentuk tanah. Anda dapat mengambil gambar ini dari internet

lengan kata kunci “texture”. Anda juga dapat men-download

bar untuk yang digunakan pada buku ini di




https:/drive.google.com/file/d/0BwzsZbp4m4sUbmNXWFBW

RnM/view?usp=sharing. Contoh gambar yang digunakan sep t
pada Gambar 3.10. '

L =~ i wa k Edit Texture sehingga muncul kotak dialog Add Terrain
. - . : 1d .GI‘JJV “”!",.

Gambar 3.10 Pilihan pola permukaan tanah

. Masukkan gambar ke dalam Unity dengan membuat folder ga
terlebih dahulu. Caranya, klik kanan pada jendela Project dan p
Create > Folder.

Gambar 3.14 Kotak dialog Add Terrain Texture

3.11 Memb Ide. K
Gambar Membuat folder baru ik Select pada kotak kiri dan ketikkan rumput.

. Selanjutnya, masukkan gambar pada folder dengan Kklik fold
Kemudian klik kanan dan pilih Import New Asset.

Gambar 3.12 Menambahkan gambar ke dalam Unity.

12. Pada jendela Inspector dari Terrain, klik Paint Texture. Gambar 3.15 Pilthan texture



15. Pilih tekstur rumput sehingga muncul di kotak dialog Add Terr:

a Anda merasa efek kabut terlalu tebal, Anda dapat mengurangi
Texture.

gka dari Density. Selain itu Anda juga dapat membuat objek
ght menjadi lebih dekat ke objek Player supaya peta menjadi
ih terang.

Gambar 3.16 Gambar texture muncul di kotak dialog Add Terrain Textu

 Gambar 3.19 Tampilan peta dengan Densiti kabut 0.05
16. Pada bagian Size buat x dan y menjadi “15". Pengaturan
merupakan ukuran texture setiap kotaknya. Kemudian klik Add.

Menambahkan Gunung

~membatasi bagian pinggir peta, Anda akan menambahkan
1g. Gunung ini akan melingkari peta sehingga karakter tidak dapat
it hingga keluar dari peta. Untuk lebih jelas, ikuti langkah-langkah

lik objek Terrain sehingga menampilkan jendela Inspector dari
errain.

Gambar 3.17 Tekstur pada peta game nda bagian Terrain Anda akan melihat beberapa tool untuk
nembuat perubahan pada terrain. Gunakan tool Raise/Lower
atau Paint Height Terrain untuk membuat gunung.

ontoh pembuatan gunung seperti Gambar 3.20.

Gambar 3.18 Kotak tekstur pada peta game




Gambar 3.20 Gunung memutari peta
Gambar 3.23 Menambahkan gambar gunung

lanjutnya, pilih tool Paint Texture.

Vsl Terrain ;i o
| a2 d. &'.-_ _ 5‘1,52434,

| Paint Texture
i} Calueta -u:-hmﬁ-:*:hd W palm

sMe@®-wC®
Rl @dNee
(R

Gambar 3.21 Tampilan gunung dengan efek kabut dalam game

Gambar 3.24 Pengaturan Paint Texture

Ik Edit Texture > Add Texture untuk mengganti gambar texture
pilih gambar batu.

Textures

| e o
\ Gambar 3.22 Tampilan gunug tanpa efek kabut dalam game

il LT [ cat Toxtures.|
’ 3. Tambahkan gambar gunung di tengah peta.
|
\

Gambar 3.25 Texlure baru dengan pola batu




6.

7.
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Pilih texture batu yang baru ditambahkan dan pilih tool dengan
lingkaran paling kecil. Kemudian terapkan pada peta untuk
membuat pola pada bagian gunung.

L LR
Wi

Gambar 3.27 Hasil menerampkan tekstur pada gunung

Jika Anda klik tombol Play Anda akan melihat perbedaan warna
tekstur antara tanah dan gunung.

Gambar 3.28 Perbedaan tekstur gunung dan tanah

3.4 Menambahkan Material

Intuk membuat peta menjadi lebih berisi, Anda akan menambahkan
eberapa material. Material yang dapat ditambahkan adalah membuat
an setapak. Selain itu Anda juga akan menghias bentuk dinding yang

utih menjadi memiliki pola. Untuk lebih jelas, ikuti langkah-langkah
arikut:

Bagian pertama yang akan Anda buat adalah membuat jalan
setapak. Jalan ini akan memiliki pola tanah berwarna cokelat.
Caranya klik objek Terrain untuk menampilkan jendela Inspector.

Tambahkan tekstur tanah dengan ukuran 10x10.

Add Terrain Texture n

Albedo (RGB) .
Smoothness (A)  Norm

|
|
1 Add ]j

Gambar 3.29 Menambahkan lekstur tanah dengan ukuran 10x10

Gunakan tool lingkaran untuk membuat tanah melingkar di sekitar
tempat berdirinya objek Player.
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Gambar 3.32 Tampilan jalan setapak dalam game

Selanjutnya, Anda akan membuat pola pada tembok. Caranya, drag
gambar pola tembok ke objek tembok.

Gambar 3.30 Membuat daerah melingkar pada peta

4. Selanjutnya buat jalan setapak dengan menggunakan tool yang
sama. Contoh jalan setapak seperti pada Garmbar 3.31.

kayu

Gambar 3.33 Pola tembok

Gambar 3.31 Membuat jalan setapak

5. Jika Anda klik tombol Play Anda akan melihat tanah berwarna
cokelat dengan pola seperti yang Anda gambar.

Gambar 3.34 Drag gambar ke objek supaya objek berubah warna

7. Lakukan langkah yang sama sehingga semua tampilan tembok
- berubah menjadi memiliki pola.
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Selanjutnya, tambahkan objek silinder sebagai tangkai lampu
dengan klik GameObject > 3D Object > Cylinder.

Gambar 3.35 Semua tombok telah memiliki pola

8. Jika Anda lihat pada jendela Inspector, Anda melihat material Gambar 3.38 Me ahkan obiek silinder
tembok juga telah berubah. ' s namb 2j!
. Ay ok Atur ukuran silinder supaya proporsional dengan lampu. Gunakan
[ l [ @ nspector [ lighting e tool Scale.
[ ) T
|l l\‘| 7, i . - . - , . : . 4 A |
i |‘ e :
| |}v bayu

L » Shader | arandard - >

1

|ty Gambar 3.36 Perbahan material tembok

9. Terakhir Anda akan menambahkan lampu yang ditempel pada Gambar 3.39 Memperkecil ukuran silinder

i Il
‘i l tembok. (ntuk melakukannya, buat objek bola dengan klik
il GameObject > 3D Object > Sphere.

. Tempelkan silinder pada objek bola.

Gambar 3.37 Menambahkan Objek bola Gambar 3.40 Menempelkan silinder ke Objek bola




13. Tambahkan objek kotak dengan klik GameObject > 3D Object >
Cube.

Gambar 3.44 Menempelkan objek lampu ke tembok

Gambar 3.41 Menambahkan objek kotak ] !
- Beri pola pada objek Cube menggunakan pola yang sama dengan

14. Sesuaikan ukuran objek kotak dengan dua objek sebelumnya dan tembok.
gabungkan semua objek.
Gambar 3.42 Menggabungkan ketiga objek Gambar 3.45 Menambahkan pola pada objek cube
15. Gabungkan objek silinder dan kotak ke dalam objek bola. . Buat material dengan klik kanan pada jendela Project. Kemudian

pilih Create Material.

s o,

. Beri nama material dengan “Pegangan lampu’”.

g "j ) . Beri warna hitam pada material dengan klik bagian warna pada

jendela Inspector.

Gambar 3.43 Membuat objek silinder dan kotak menjadi child objek bola

16. Ubah nama objek bola menjadi “Lamp”.
17. Tempelkan objek ke tembok.
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O inspector [ miiahfing. RN
pegangan lampu
shader | Standeed

pegangan |
Gambar 3.46 Pengaturan warna dan hasil pewarnaan material

22. Drag material ke objek Cylinder.

Gambar 3.47 Pegangan lampu menjadi hitam

23. Buat kembali material warna putih untuk bagian bola lampu.

24. Berikan warna putih pada material.
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Gambar 3.48 Menambahkan material warna pada objek bola lampu

. Pada jendela Inspector Anda akan melihat bagian Material dapat
diedit. Klik bagian Shader dan pilih Sprite > Diffuse.

bola lampy Go I
v Shader | Standard S
‘Lﬁ' Standard

Standard {Specular setup)
124 >
Gul >
Mobile >
Nature

) H_"“' Particles

Gambar 3.49 Memberi warna pada bola lampu

., Selanjutnya, klik bagian Tint sehingga ditampilkan kotak dialog
untuk memilih warna.

7. Pilih warna untuk bola lampu dengan warna yang Anda inginkan.
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. Pada jendela Inspector lakukan pengaturan seperti menambahkan
bayangan dan ukuran cahaya seperti Gambar3.53.

Gambar 3.50 Pengaturan warna lampu

28. Hasilnya warna lampu berubah.

Gambar 3.51 Perubahan warna lampu

29. Selanjutnya, buat efek cahaya di dalam lampu dengan Kklik
GameObject > Light > point Light.

Gambar 3.54 Tampilan cahaya bola lampu

Gambar 3.52 Menambahkan efek cahaya

30. Letakkan cahaya di dalam objek bola lampu.
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Qerdasarkan Gambar 3.56, Anda dapat melihat beberapa objek
pohon. Drag objek ke jendela Scene untuk menampilkan pohon.

Gambar 3.55 Tampilan lampu dalam game

3.5 Membuat Objek Pohon ‘

Untuk membuat objek pohon, ada dua cara yang dapat Anda lakukan
Pertama adalah menambahkan objek pohon yang telah jadi. Kedua
menggunakan asset Tree yang hanya menampilkan batang pohon da
ditambahkan objek daun. Untuk lebih jelas, ikuti langkah-langkah
berikut:

Gambar 3.57 Menambahkan objek pohon

Cara lain menambahkan pohon dengan klik GameObject > 3D
Object > Tree.

1. Objek pohon sebenarnya telah ada saat Anda menambahkan assel GUAOMER] Componemt Mobie input Window el
~ s : . . . Creste [mpt, Carie Shitte N
Terraln.. Untuk mencari objek pohon, pada jendela Project pilil P SN M -
kategori All Models. OGNNSR o
30 Object
Laghe
T Favartes search (EERDD Aurdia

"
Paticle Symem
Camaers

ek trs .

Rhake Fa

Gambar 3.58 Klik GameObject > 3D Object > Tree

Anda akan melihat batang pohon di jendela Scene.

T DT Commmacint iban

i :

Humenedtd

Gambar 3.56 Tampilan semua model yang ditambahkan ke dalam Unity




49 Objek batang pohon
objek Tree Anda melihat pengaturan

yaturan pohon

1 tampilan batang.

2ot braneh epline point ond dreg te move

‘A""‘ “‘A i

;w! qﬁ%ig

Bresh Material  @Hone (Material]

- b BRSNS
Gambar 3.61 Pengaturan batang

. Pada bagian Distribution, isi bagian Frequency dengan "5” supaya
batang pohon menjadi bercabang 5. Kemudian pada Distibution
pilih Opposite sebagai bentuk percabangan yang tersebar.

Gambar 3.62 Pengaturan bagian Distribution

Anda akan melihat batang lima pohon yang tersebar dalam area
melingkar.

83




Pada bagian Distribution buat Area Spread menjadi "0" supaya
cabang pohon menyatu menjadi satu pohon yang bercabang.

Gambar 3.63 Tampilan batang pohon Gambar 3.65 Membuat cabang pohon menyatu
9. Pada bagian Geomatry pilih pola untuk Branch Material dan Brgak | Tambahkan gambar daun pada Gambar 3.60 untuk
Materia! dengan pola yang sesuai sehingga batang pohon menjad| menambahkan dau pada batang pohon. Caranya, klik gambar daun
memiliki pola. di bawah kotak dialog.

Gambar 3.66 Klik gambar daun

. Anda akan melihat tambahan gambar daun.

Gambar 3.64 Batang pohon menjadi memiliki pola

10. Selanjutnya, klik pada gambar pohon pada Gambar 3.60 untuk Gainbar 167 Minanibalikan pancitiican daun
mengatur tampilan pohon.




14. Klik gambar daun di jendela Scene untuk mengatur posisi daun di

Anda akan melihat tampilan pohon yang dilengkapi daun.
pohon. !

|

Gambar 3.71 Tampilan pohon

1
~ Anda dapat menggeser posisi daun dengan drag lingkaran.
Gambar 3.68 Menyesuaikan posisi daun ’

15. Pada bagian Distribution buat Frequency dengan “10" untuk

menentukan banyaknya daun. Kemudian pilih distribution dengan
Alternate untuk memnentukan penyebaran daun.

[ Gambar 3.72 Tampilan akhir pohon
Gambar 3.69 Mengatur penyebaran daun ‘

16. Pada bagian Geometry pilih pola gambar daun yang sesuai. 1

Gambar 3.70 Menambahkan pola pada daun
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Gambar 3.73 Tampilan pohon dalam game

' MEMBUAT SISTEM GAME

a bab ini Anda akan membuat sistem game. Sistem game yang akan
uat antara lain menambahkan pilihan senjata, pengaturan musuh,
) pengaturan lebih lanjut terhadap karakter. Setelah Anda membuat
em game, kondisi game akan menjadi lebih menarik. Untuk lebih
s, ikuti pembahasan pada bab ini.

Menambahkan Pilihan Senjata

npai saat ini Anda hanya memili senjata Mace yang telah dibuat pada
b 2. Pada bab ini Anda akan menambahkan senjata baru dengan
npilan yang jauh lebih baik. Senjata ini dapat Anda peroleh dari link
wnload yang telah dituliskan pada Bab 3 yang berisi gambar tekstur.
luk lebih jelas, ikuti langkah-langkah berikut:

Perbaiki bentuk tampilan objek Mace dengan meperbesar bentuk
bola dan memperpendek bagian pegangan/Grip.
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Tambahkan tekstur pada objek Mace dan Grip supaya senjata
warna. Anda dapat menggunakan tekstur batu sebagal

memiliki
pewarna.

Tambahkan senjata baru dengan menambahkan asset Sword dari
file yang Anda download.

Gambar 4.1 Tampilan objek Mace yang baru

Gambar 4.3 Menambahkan pedang

Tambahkan tekstur pedang dari file yang Anda download.

Gambar 4.2 Memberi tekstur apda mace

Gambar 4.4 Menambahkan tekstur pada pedang




5. Selanjutnya, buat skrip baru pada Melee dengan nama
“WeaponSwitch" dengan menggunakan Javascript.

6. Buat variabel seperti berikut.

var Weaponl : GameObject; ~
var Weaponz : GameObject;

Variabel di atas akan menampilkan dua jenis senjata yang dapat
digunakan oleh karakter.

7. Selanjutnya, tulis skrip seperti berikut.

function Update ()
%f (Input.GetKeyDown (KeyCode.Q))

SwapWeapon () ;

}

function SwapWeapon ()
if (Weaponl.activeInHierarchy == (true))

Weaponl.SetActive (false) ;
Weapon2 , SetActive (true) ;

}

else

{
Weaponl.SetActive (true) ;
) Weapon2.SetActive (false) ;
)

Berdasarkan skrip di atas, Anda dapat mengganti senjata dengan
klik tombol @Q pada keyboard. Pada fungsi SwapWeapon akan

memberikan perintah hanya satu senjata yang muncul saat Anda
menekan Q.

Pada fungsi SwapWeapon Anda akan melihat fungsi
activelnHierarchy. Pada bagian ini akan memberikan pilihan saal
senjata 1 aktif, maka senjata 2 akan dihilangkan. Hal ini juga
berlaku sebaliknya saat enjata dua aktif, senjata satu dihilangkan.
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var Weaponl @ famectieat;
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Gambar 4.5 Tampilan lengkap skrip WeaponSwitch

Jika Anda lihat jendela Inspector dari objek Melee Anda melihat
komponen baru yang mendaftarkan dua senjata untuk karakter.

Masukkan senjata mace dan sword pada kotak yang berbeda.

Gambar 4.6 Mendaftarkan senjata

. Jika Anda klik tombol Play Anda akan melihat senjata berhasil

ditampilkan. Untuk mengganti senjata klik Q.

Gambar 4.7 Senjata berhasil ditampilkan
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11. Saat Anda memulai game, Anda akan melihat kedua sen|
ditampilkan secara bersamaan. Untuk menanganinya, cu
hilangkan tanda pada kotak inspector dari salah satu senjata y
tidak ingin ditampilkan saat awal permainan.

-
v

O inspector || ELighting &
) Mace ~ Cistatic

Tag [Untagged ¢ | Layer | Default

Gambar 4.8 Menghilangkan tanda untuk menyembunyikan senjata

12. Anda akan melihat hanya ada satu senjata pada jendela Sc Gambar 4.10 Mengganli senjata dengan menekan Q

seperti Gambar 4.9.

13. Jika Anda jalankan kembali game, Anda hanya melihat satu sen
saja yang ditampilkan. Untuk mengganti senjata klik tombol

seperti Gambar 4.10.

njata Mace dap'at Anda gerakkan saat klik kiri mouse, akan tetapi
. jata pedang tidak. Hal ini karena pada senjata pedang Anda
lum menambahkan animasi gerakan.

.tuk membuat animasi, klik objek Sword dan klik jendela
imation.

t animasi dengan nama Sword.
ambahkan komponen Position dan Rotation dari Transform.

r pergerakan objek Sword sebagai animasi pergerakan objek.

Gambar 4.9 Senjata yang ditampilkan hanya yang diberi tanda pac
kotak Inspector

Gambar 4.11 Gerakkan mengayunkan pedang

| Ctl.'l+S untuk menyimpan animasi jika Anda selesai membuat




20. Selanjutnya, klik jendela Inspector dariobjek Sword. Tamba
komponen Animation.

21. Masukkan animasi Sword yang telah dibuat.

}

skrip di atas juga sama dengan penulisan skrip
‘ System. Perbedaan yang terjadi adalah penggantian variabel
e menjadi Weapon. Sedangkan pada bagian Play diganti dari
ck menjadi Sword.

. ””
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Gambar 4.12 Menambahkan animasi pada objek Sword

22. Selanjutnya, klik objek Melee dan tambahkan Javascript de
nama “MeleeSystemSword".

23. Buat variabel seperti berikut. B T = T o e e T

il
!1
i

var Damage : int = 50;
var Distance : float;
var MaxDistance : float = 1.5;
var Weapon : Transform;

Gambar 4.13 Skrip lengkap sistem pergerakan pedang

jutnya, pada jendela Inspector dari objek Melee daftarkan

i ata ‘
Variabel di atas sama dengan variabel saat Anda mem ek Sword pada Melee System Sword.

MeleeSystem pada Bab 2. Akan tetapi, bagian var Mace dig
dengan var Weapon. Bagian ini juga dapat Anda terapkan |
MeleeSystem, sehingga pada jendela Inspector objek Melee
lagi menampilkan senjata dengan nama senjata (Mace) tetapi 4
menampilkan Weapon.

24. Selanjutnya, tulis skrip berikut.

function Update ()

!
if (Input.GetButtonDown("Firel")) Gambar 4.14 mendaftarkan objek pada komponen Melee

Weapon.animation,Play ("Sword") ; lanka
Neagon. ar Mo lankan k?i:n;; dan Anda dapat menggerakkan pedang saat

if (Physics.Raycast (transform.position,
transform.Transformbirection (Vector3. forward), hit))

pistance = hit.distance;
if (Distance < MaxDistance)

hit.transform.SendMessage ("ApplyDammage", Dama
SendMessageOptions.DontRequireReceiver);



Gambar 4.15 Gerakan mengayunkan pedang

4.2 Membuat Sistem Kendali Musuh

Sampai saat ini musuh yang Anda hadapi hanya diam saja. Dala

sebuah game tentu hal ini tidak menarik. Oleh karena itu, Anda perl
membuat sistem kendali musuh yang secara otomatis akan melakukan
perlawanan terhadap karakter. Untuk lebih jelas, ikuti langkah-langkaly
berikut:

Klik objek Enemy dan tambahkan Javascript dengan nama
“EnemyAl".

Gambar 4.16 Menambahkan skrip musuh

Buka skrip dan hapus semua skrip default.
Selanjunya, buat variabel seperti berikut.

var Distance : float;

var Target : Transform;
var LookAtDistance = 25,0;
var AttackRange = 15.0;
var MoveSpeed =5.0;

var Damping = 6.0;

Variabel di atas digunakan untuk mengatur jarak antara musul
dengan karakter. Selain itu variabel di atas juga mengatul
kecepatan gerak musuh. Variabel Damping adalah variabel

tambahan untuk menghaluskan gerakan karakter. Tulisan #
pragma strict juga dihapus.

Selanjutnya, tuliskan skrip berikut.

function Update ()

Distance = Vector3.Distance (Target.position,
transform.position) ;

if (Distance < LookAtDistance)

renderer.material.color = Color.yellow;
lookAt () ;

if (Distance > LookAtDistance)

renderer.material .color = Color.green;

if (Distance < AttackRange)

renderer.material.color = Color.red;
attack ();

)

| function lookAt ()

var rotation =
‘ Quaternion.LookRotation(Target.position -
transform.position) ;
transform.rotation =
I Quaternion.Slerp(transform.rotation, rotation,
Time.deltaTime * Damping);

function attack ()

transform,Translate (Vector3.forward * MoveSpeed *
Time. deltaTime) ;

Berdasarkan skrip di atas, untuk mengetahui seberapa dekat
karakter terhadap musuh diberikan warna sesuai jarak. Jika karakter
di luar jangkauan (LookAtDistance) musuh, objek Enemy akan
berwarna hijau. Jika karakter dalam jarak jangkauan musuh, maka
‘objek Enemy berwarna kuning. Jika karakter ada di dalam
angkauan (AttackRange) serangan musuh, musuh akan berwarna

‘merah dan mengejar karakter.

Fungsi lookAt menjelaskan perubahan reaksi objek Enemy terhadap
objek Player. Fungsi attack menjelaskan pengaturan kecepatan
gerak objek Enemy.



Gambar 4.19 Mendaftarkan objek Player ke objek Enemy

Klik tombol Play untuk menguiji reaksi objek Enemy.

Gambar 4.17 Tampilan skrip lengkap

Gambar 4.20 Musuh berwarna hijau saat karakter di luar jangkauan
5. Untuk menguji skrip di atas, letakkan objek Enemy agak jauh dari musuh

objek Player.

Gambar 4.18 Memberi jarak objek Enemy (kiri) dengan objek Player ambar 4.21 Musuh menjadi kuning saat karakter masuk dalam wilayah
(kanan) iy

6. Daftarkan objek Player ke komponen skrip objek Enemy.
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if (theCollider == "Player")

GetComponent , <AudioSources () .Playl();
GetComponent . <AudioSources () ,loop = true;

i }

function OnTriggerExit (other : Collider)

theCollider = other.tag;
if (theCollider == "Player")

GetComponent . <AudioSource> () .Stop () ;
GetComponent . <AudioSources> () ,lcop = false;

}

iflabel the Collider digunakan sebagai pendeteksi jika karakter
lemasuki wilayah yang akan dimainkan musik. Pada fungsi
InTriggerEnter mengatur untuk memainkan musik saat karakter
asuki wilayah. Fungsi OnTriggerExit mengatur untuk
atikan musik saat karakter keluar dari wilayah.

udio digunakan pada Unity5. Pada Unity versi 5 Anda dapat
snuliskan Getcomponent . <audiogources () sehingga menjadi

Gambar 4.22 Musuh berwarna merah dan mengejar karakter

8. Jika saat objek Enemy berwarna kuning dan objek Player men|s
musuh, objek enemy dapat menjadi berwarna hijau kembali.

4.3 Menambahkan Suara

GetComponent . <AudioSources () .Play,
GetComponent ., <AudicS8ocurces ().Stop, dan
GetComponent . <AudicSources () . loop.
Untuk membuat game menjadi lebih ramai, Anda dapat menambalily

suara dalam game. Pada pembahasan ini Anda akan menambal
BGM (background music) saat karakter ada di posisi tertentu. Unl
lebih jelas, ikuti langkah-langkah berikut:

1. Buat Javascript baru tanpa membuat objek dengan nai
"AudioZone”.

Gambar 4.23 Membuat skrip untuk musik

2.  Hapus skrip dasar dan tuliskan skrip berikut. Giniber 4.24 Skrlp lengkap dart AindioZone

private var theCollider : String;

Selanjutnya, buat objek dengan klik GameObject > Create Empty.

function OnTriggerEnter (other : Collider)

{ Canti nama objek dengan “Audio Zone".

theCollider = other.taq;




5. Selanjutnya, tambahkan komponen collider pada objek Audio Zos
dengan cara klik Add Component dan ketikkan “collider”,

6. Selanjutnya, pilih Sphere Colider dan beri tanda pada Is Trigger.

isukkan asset musik yang Anda inginkan. Anda dapat
nggunakan asset musik dari file yang Anda download pada Bab

O Inspector Assets » mslk "

@ ¥ mudzone
Tag | Untagaed ¢ | Layer

Gambar 4.27 Asset musik yang akan digunakan

rag FriendlyMusic atau musik yang Anda inginkan pada jendela
7 or dari objek Audio Zone.

slanjutnya, beri tanda pada Play On Awake seperti Gambar 4.28.
luka jendela Inspector dari objek Player.

ada bagian Unttagged menjadi Player seperti Gambar 4.29.

Gambar 4.25 Komponen objek Audio Zone ik tombol Play untuk menguji game.

7. Selanjutnya, letakkan objek di daerah lingkaran seperti Gaml
4.26. Gunakan tool Scale untuk memperbesar ukuran objek d
Position utuk menggeser objek.

Gambar 4.28 Komponen musik

Gambar 4.26 Meletakkan objek Audio Zone
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© Inspector iﬁﬁﬁm._x@
™ Player
Tag | Phi- i) Layer D-huh

Prefab Untagged

). Saat ini Anda akan memiliki dua musik yang berbeda, yaitu pada
daerah lingkaran dan pada wilayah musuh.

L Jika Anda ingin musik pada wilayah musuh bergerak mengikuti

Ta Respawn
::.": Finish pergerakan musuh, buat objek Audio Zone 2 menjadi child dari
ihealy  Fowony & objek Enemy.

3 MainCamera

e

GameController

§§ . AddTag.
i

Gambar 4.29 Mengubah Tag objek Player

14. Jika Anda mengatur dengan benar, saat karakter Anda memasukl
wilayah Audio Zone akan terdengar musik/BGM. Musik ini akan
berhenti jika karakter menginggalkan wilayah Audio Zone. Hal inl
dipengaruhi dari Tag objek karakter yang telah menjadi Player
Selain itu, jika karakter Anda seperti menabrak tembok saat akan
masuk ke wilayah Audio Zone, berarti Anda belum memberi tanda
pada bagian Is Trigger dari komponen Sphere Collider.

15. Salin objek Audio Zone dan beri nama “Audio Zone 2".
16. Letakkan objek Audio Zone 2 di daerah objek Enemy.

Gambar 4.31 Objek musik menjadi child dari objek musuh

). Jika Anda jalankan dalam game, musik akan mengikuti pergerakan
musuh. Hal ini berbeda dari sebelumnya, di mana saat Anda keluar
dari wilayah musik, musik akan menghilang.

4 Meningkatkan Sistem Kendali Musuh

da pembahasan ini Anda akan meningkatkan kemampuan musuh.
impai saat ini musuh tidak memberikan efek apapun kepada karakter
it musuh mendekati karakter. Anda akan menambahkan efek seperti

suh dapat membunuh karakter. Untuk lebih jelas, ikuti langkah-
ngkah berikut:

Hapus komponen Capsule Collider dari jendela Inspector objek
Enemy.

Tambahkan komponen Character Controller dengan klik Add
Component dan ketikkan “character controller”.

Gambar 4.30 Meletakkan objek Audio Zone 2

17. Selanjutnya, ganti musik dengan asset EnemyTerritory atau musik
yang Anda inginkan.
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njutnya, ketikkan skrip seperti berikut.

lunction Update ()

Distance = Vector3.Distance (Target.position,
Eransform.position) ;

if (Distance <« LookAtDistance)
lookAt () ;
if (Distance > LookAtDistance)

GetComponent , <Renderers () .material.color =
‘Color.green;

if (Distance < ChaseRange)

chase ();

unction lookat ()

Gambar 4.32 Perubahan komponen objek Enemy N GetComponent . <Renderers> () .material.color =
Color.yellow;

8 5 ; o var rotation =

Selanjutnya, non aktifkan skrip EnemyAl dengan menghilang ‘Quaternion.LookRotation(Target.position -

g Etransf 2 ition) ;
tanda centang pada bagian kiri atas. B ot s iaich o
Buat skrip dengan Javascript dan beri nama “AdvancedAl”.

‘Quaternion.Slerp(transform.rotation, rotation,
Time.deltaTime * Damping) ;
1 \

Salin semua skrip dari EnemyAl dan hapus bagian #pragma stri¢

function chase ()
Selanjutnya, buat variabel menjadi seperti berikut. { :
GetComponent . <Renderer> () .material.color =
Qolor.red;
var Distance;
var Target : Transform; moveDirection = transform. forward;
var LookAtDistance = 25.0; moveDirection *= MoveSpeed;

var ChaseRange = 15; 1 L '
var AttackRange = 5.0; v moveDirection.y -= gravity * Time.deltaTime;

var MoveSpeed =5.0; controller.Move (moveDirection * Time.deltaTime);
var Damping = 6.0; }
var controller : CharacterController;

var gravity : float = 20.0; \da beberapa perubahan dari skrip di atas. Perubahan warna yang
private var MoveDirection : Vector3 = Vector3.zero; N - g
belumnya di dalam fungsi if langsung dimasukkan ke dalam
Pada variabel di atas, terdapat beberapa tambahan varial ungsi tujuan (lookAt dan chase). ChaseRange menggantikan
ChaseRange merupakan variabel untuk menentukan jarak anta ttackRange sehingga musuh akan mengejar karakter dalam jarak
musuh dan karakter supaya musuh mengejar karakter. Varial . Fungsi chase akan mengatur pergerakan musuh saat mengejar
AttackRange dikurangi menjadi 5. Variabel controller un arakter.

mengendalikan pergerakan musuh. Variabel gravity mejaga supa Bmbali ke Unity dan daftarkan CharacterController
i i - yang
musuh tetap menempel di tanah. Variabel MoveDirection a b
mengatur pergerakan objek menjadi 3 dimensi (Vector3). R citambishilisin e ddlan Advanced Al
Jaftarkan objek Player ke dalam Advanced Al.



10. Jalankan tombol Play untuk menguiji pergerakan musuh.

v 1 M Advanced AT (Script) [N
Script __ AdvancedAl @
Tu'!gg&%m . [APlayer (Transforr ©
© Look At Distance 25 :

Chase Range 15
Attack Range |5

ﬂd@;%ﬁeed e
Pl .
Cartroller ~ Enemy (Characte) ©

Gravity 20

bar 4.35 Objek Enemy mengejar objek Player tetapi terhalang

Gambar 4.33 Mendaftarkan Target dan Controlle ke Advanced Al sk

anjutnya, Anda akan menambahkan serangan pada musuh
pngan tambahkan variabel berikut.

var attackRepeatTime = 1;

private var attackTime : float;

wriabel di atas digunakan supaya musuh dapat melakukan
rangan berulang-ulang dengan jeda waktu tertentu.

at fungsi start seperti berikut.

function Start ()

Gambar 4.34 Objek Enemy yang mengejar objek Player sambil tetap
menempel tanah

attackTime = Time.time;

J

Buat fungsi if di dalam fungsi update.

11. Jika Anda coba menaruh objek Enemy di belakang tembok, ol
akan mengikuti pergerakan karakter tetapi tidak dapat meneml

if (Distance <« AttackRange)
tembok.

attack ();

J

else

Letakkan fungsi ini di atas if (Distance < ChaseRange). Fungsi ini
‘akan membuat objek Enemy berhenti mengejar objek Player jika
‘ubjek akan menyerang objek Player. Jika objek Player berusaha
‘menjaduhi objek Enemy, objek Enemy akan mengejar kembali

‘ubjek Player dan akan berhenti saat objek Enemy akan menyerang
objek Player.
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15.

16.

17.

112

Untuk membuat supaya objek Enemy berhenti tidak terlalu jauh |
objek Player, Anda dapat mengubah AttackRange menjadi
Lakukan perubah ini di jendela Inspector setelah Anda sel

membuat skrip Advance Al ini. tra

-~

Buat fungsi attack seperti berikut. ~ *

function attack ()
if (Time.time > attackTime)

Debug.Log ("Melakukan serangan');
attackTime = Time.time + attackRepeatT}

}

Fungsi ini akan menyerang karakter jika karakter berada di dal
jarak serang musuh (AttackRange). Pada saat objek

menyerang objek Player, Anda akan melihat pesan “Melakul
serangan” pada jendela Console. Serangan juga dilakukan de 3
menggunakan jeda karena Anda telah menambahkan attackTi

Buat fungsi ApplyDamage seperti berikut.

function ApplyDammage ()

ChaseRange *= 30;
MoveSpeed *= 2;
LookAtDistance *= 40; {

}

Fungsi ini akan mengatur pergerakan musuh saat mu
menyerang. Dengan pengaturan ini, Anda akan menjadi lebih
lari dari objek Enemy.

Skrip lengkap dari AdvancedAl seperti berikut.
1

var LoockAtDistance = 25.0;
var ChaseRange = 15;

var AttackRange = 1.5; %
var MoveSpeed =5.0; b
var Damping = 6.0;

var attackRepeatTime = 1;

private var attackTime : float;

L
var controller : CharacterController; A)
var gravity : float = 20.0;
private var moveDirection : Vectorl = Vector3.zero;
function Start ()

attackTime = Time.time;

{pnction Update ()

Distance = Vector3.Distance (Target.position,

sform.position);

%f (Distance < LookAtDistance)
| lookAt () ;
if (pistance > LookAtDistance)

renderer.material.color = Color.green;

if (Distance < AttackRange)

attack ();

1

else
%f (Distance < ChaseRange)

chase ();

}

unction lookAt ()

renderer .material.color = Color.yellow;
var rotation =

Quaternion LookRotation (Target .position -
transform,position) ;

transform.rotation =

Quaternion.Slerp(transform.rotation, rotation,
@ime deltaTime * Damping) ;

function chase ()

renderer .material.color = Color.red;

moveDirection = transform.forward;
moveDirection *= MoveSpeed;

moveDirection.y -= gravity * Time.deltaTime;
controller.Move (moveDirection * Time.deltaTime);

function attack ()

if (Time.time > attackTime)

Debug.Log ("Melakukan serangan') ;
attackTime = Time.time + attackRepeatTime;

fUnction ApplyDammage ()

ChaseRange *= 30;
MoveSpeed *= 2;
LookAtDistance *= 40;
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}
18. Klik tombol Play untuk menguji game.

19. Pada saat musuh mengejar karakter, musuh akan berhentl
mengejar (berwarna kuning) untuk menyerang karakter.

Gambar 4.38 Pesan musuh sedang menyerang karakter

., Anda juga akan kesuitan untuk menghindari musuh karena
perubahan pada fungsi ApplyDamage.

Gambar 4.39 Musuh lebih agresif mengejar karakter

Gambar 4.37 Attack Range diubah menjadi 1.5 supaya musuh berhenti
tidak terlalu jauh dari karakter 5 Membuat Nyawa pada Karakter
20. Jika Anda lihat pada jendela Controller Anda akan menemukan

pesan “melakukan serangan”. Pesan ini sebagai tanda musuh ffida pembahasan ini Anda akan ::ena&n l:a:l;ag“:l )-(:l“al: ?:li? |:?,rgak‘:;f
sedang menyerang karakter. Tanda ini dilakukan sementara karena lipaya musuh dapat melukal karaiaar: Crntclenin jeias,
karakter belum memiliki nyawa. Pesan ini juga dilakukan dengan ngkah berikut:

menggunakan jeda waktu. . Klik objek Enemy dan hapus skrip EnemyAl.
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n skrip lengkap dari EnemyLogic.
ipragma strict

: Health = 100;

function ApplyDammage (Damage : int)

Health -= Damage;
if (Health < 0)

Gambar 4.40 Menghapus skrip EnemyAl y ) Dead () ;

Buka kembeali skrip AdvancedAl dari objek Enemy.
Tambahkan variabel baru seperti berikut.

var Damage = 35; ‘ }

Pada fungsi attack ubah menjadi seperti berikut. anjutnya, tambahkan komponen Javascript pada objek Player

function Dead ()
o

Destroy (gameObiject) ;

gan nama “PlayerLogic” seperti Gambar 4.41.
f“““““ attack () ka skrip PlayerLogic dan ganti semua skrip default dengan skrip
%f (Time.time > attackTime) g telah Anda salin.

Target .SendMessage ("ApplyDammage",

Damage) ;

Debug.Log ("Melakukan serangan") ;
attackTime = Time.time + attackRepeat!|

) }

Skrip di atas menjelaskan musuh akan melukai target deng
serangan sebesar variabel Damage, yaitu 40 poin.

Selanjutnya, buka skrip EnemyLogic dari objek Enemy.
Hapus bagian fungsi Update.
Selanjutnya, ubah bagian ApplyDamage menjadi seperti berikut. Gambar 4.41 Menambahkan skrip PlayerLogic

funccion ApplyDammage (Damage : int) k tombol Play untuk menguji game.

Health -= Damage; a Anda mendekati musuh, musuh akan menyerang dan
g (Hewlth ¢ 0) ngeluarkan pesan serangan.

Dead ();
) I

)

Skrip ini telah menambahkan kegunaan dari fungsi Update ya
telah dihapus sebelumnya. Skrip ini menjelaskan pengurang
nyawa dari objek dan setelah nyawa menjadi O objek akan men

fungsi Dead.



Lag(Obwet)

AN
ah ILog(Ohject)
I 10 AUD [ieteners in the scene, Hleave ensure B (6 always one sudiy listennr i the sesne

1% 10 auilin listanees i the scene, P|ease snsure thee & always ann sudi listener i the soens

caption: The shject of typn ‘Tryanstorm’ has bewn destroyed bot you are still rying to aocwas .
M crllm check (Fitm null ot you should not destesy the abiect.

. - PSR Pt

bar 4.45 Setelah 3 serangan objek Player menghilang

m! Gambar 4.42 Musuh menyerang karakter ilka kembali skrip PlayerLogic.
hah fungsi Dead menjadi seperti berikut.

function Dead ()

Debug.Log ("Karakter Terbunuh"):

fip ini mengganti penghancuran objek Player saat mati menjadi
unya pesan bahwa “Karakter Terbunuh™.

I '] i‘i' :";l Gambar 4.43 Musuh menyerang karakter sebanyak dua kali I p lengkap dari PlayerLogic sebagai berikut
ol S
o & ! W
i 13. Setelah serangan ketiga, objek Player akan hilang dari jent B tacna strict
N Game. Hal ini karena musuh telah melakukan serangan sebail e
1 il 105 poin yang berarti melebihi nyawa objek Player yang hanya (i i Health = 100;

. ) . function ApplyDammage (Damage : int)
14. Anda juga akan mendapatkan pesan lain karena menghilang
objek Player.

Health -= Damage;
if (Health < 0)

Dead ()
}
function Dead ()

Debug.Log ("Karakter Terbunuh");

}
Ik Play untuk menguji game.

]

saat nyawa karakter menjadi kurang dari sama dengan 0, muncul
san “"Karakter Terbunuh”.

Gambar 4.44 Karakter menghilang dari jendela Game
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Cansole

\ I{ddtulu serangan
f Engine.Debug:Log(Object)
Q ‘Melakukan serangan
UnityEngine.Debug:Log(Object)

Q Karakter Terbunuh [~
unltyEngmc.chuml.oo(ob;ia)

L

kukan seranga Y
ne.Debug: Log(Objnk)

Q Karakter Terbunuh 2
UnityEngine.Debugilog{Object)

{ \) Melakukan serangan
UnityEngine.Debug:Log(Object)

” Sabionic Tamuda "

Gambar 4.46 Pesan Karakter Terbunuh saat nyawa karakter menfail Gambar 4.48 Menambahkan asset pintu
20. Meskipun pesan muncul, objek karakter masih terlihat di je

bahkan collider pada objek pintu dan tembok. Pada objek
Game karena kondisi mati karakter telah diubah.

“ be2 tambahkan komponen Mesh Collider. Pada objek
Surfacel tambahkan komponen Box Collider.

4.6 Membuat Pintu

:

Lo ] ea cotiger
Is Trigger m

Pada pembahasan ini Anda akan membuat pintu yang menutup tef
yang Anda buat sebelumnya. Untuk membuat pintu, ikuti lang
langkah berikut:

1. Masukkan asset pembuat pintu dari file yang Anda download |
Bab 3.

LD Y0.070 %go.ocossu
*10 uum rm‘mo. !
v{yﬂmuumumm T’E

. LDnd.o.le L |

M
Doorlv @o.
» Shader | Standard

Gambar 4.49 Menambahkan Box Collider pada polySurfacel

uat objek baru dengan klik GameObject > Create Empty.

Gambar 4.47 Memasukkan assel pintu

fambahkan Box Collider dan buat supaya objek menjadi seukuran
tu dan berada di tengah pintu.

2. Letakkan asset ke dalam jendela Scene. !
’ at objek memiliki lebar melebihi pintu.
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Gambar 4.50 Membuat objek Trigger

7. Beritanda pada Is Trigger.

Buat objek menjadi child dari polySurfacel.

9. Beri nama objek dengan nama “Trigger”.

10. Buat Javascript pada jendela Inspector dari objek Trigger dei
nama “DoorLogic”.

\770 Inspector  |Laskighting. Al il
€@ ™ Trigger ST MANTED ¥
[ *" Tag | untagged % | Layer |Default . 32

L T Teansform. . oo il &
Josition % -0.0385 ¥ 0.13398' Z 0.09287
Wotetien fo ___¥lo &0 |

Seale  X|0.0286) ¥ 0.028672 0.02867

Gambar 4.51 Menambahkan DoorLogic pada objek Trigger

11. Ketikkan skrip berikut.

#pragma strict

function update ()

{
}

function OnTriggerEnter (theCollider : Collider)

122

if (theCollider.tag == "Player")

Debug.Log ("pintu terbuka") ;

da fungsi OnTriggerEvent memberikan informasi jika objek

ingan tag “Player” masuk ke dalam objek Trigger, akan muncul
pintu terbuka.

k tombol Play untuk menguji game.

bar 4.52 Pesan “pintu terbuka” saat karakter mendekati pintu

mbali ke skrip DoorLogic dan ketikkan seperti berikut.

fpragma strict
private var drawGUI = false;

function update ()

I

function OnTriggerEnter (theCollider :

Collider)
if (theCollider.tag == "Player")
drawGUI = true;
\ }
function OnTriggerExit (theCollider : Collider)

if (theCollider.tag == "Player")

drawGUl = false;
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function OnGUI ()
if (drawGUl == true)

GUI .Box (Rect (Screen.width#*0.5-
51,15,250,25), "Klik E untuk memgpka pintu");
} v

}

Berdasrkan skrip di atas, Anda menambahkan variabel drawGUl
untuk menggambar pesan petunjuk membuka pintu. Pada fungsi

OnTriggerEnter perubahan Debug.Log menjadi drawGUI bertujuan
supaya pesan hanya muncul saat karakter berada di dalam objek
trigger. Fungsi OnTriggerExit digunakan untuk menghapus pesan
saat karakter meninggalkan objek Trigger. Fungsi OnGul
menampilkan posisi pesan dan tampilan pesan petunjuk cara
membuka pintu.

14. Klik tombol Play untuk menguji game.

15. Anda akan mendapatkan pesan untuk membuka pintu. Akan tetapl
pintu belum dapat terbuka karena Anda belum membuat skrip
membuka pintu.

Gambar 4.53 Pesan untuk membuka pintu muncul di layar

16. Jika Anda menjauhi pintu, pesan akan hilang kembali.

17. Selanjutnya, tambahkan variabel baru seperti berikut.

var theDoor = Transform;

var anim : Animation;

private var drawGUIl = false;
private var doorlsClogsed =true;
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Variabel theDoor untuk mengatur pergerakan pintu. Variabel anim
digunakan untuk memainkan animasi pergerakan pintu. Variabel
doorlsClosed digunakan untuk membuat animasi pintu menutup.

Isi pada fungsi Update seperti berikut.

function update ()

if (drawGUI == true &&
Input .GetKeyDown (KeyCode .E) )
{

changeDoorState ({);

)
}

Fungsi ini membuat tombol E berfungsi untuk membuka pintu.
Selanjutnya, buat fungsi change DoorState seperti berikut.

function changeDgorState ()

{

if (doorlsClosed==true)

anim.CrossFade ("Open") ;
doorlsClosed = false;
yield WaitForSeconds (3);
anim.CrossFade ("Close");
doorlsClosed = true;

}
}

~ Fungsi ini memberikan perintah untuk menjalankan animasi

membuka pintu. Anim.CrossFade digunakan pada Unity 5. Anda
dapat menggunakan theDoor.animation.CrossFade pada Unity versi
sebelumnya. Yield digunakan untuk meberi jeda antara animasi

~ membuka dan menutup pintu.

. Tampilan lengkap skrip membuka pintu seperti berikut.

#fpragma strict

var theDoor : Transform;
private var drawGUI = false;
private var doorlsClosed =true;

function update ()

if (drawGUI == true &&
Input ,GetKeyDown (KeyCode.E) )
{

changeDoorState() ;

I
f

function OnTriggerEnter (theCollide:
{

: Collider)
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if (theCollider.tag == "Player") " - 2 R
. Buat lagi animasi dengan nama “Close".
drawGUI = true; n giia
) ) 8. Gunakan posisi terakhir dari animasi Open sebagai titik 0.

). Kemu isi pi i ti
function OnTriggerExit (theCollider : Collider) 1 dian buat pOSISi pintu menutup di titik 20.

-
if (theCollider.tag == "Player")

drawGUI = false;
}
}

function OnGUI ()

{

if (drawGUI == true)

GUI.Box (Rect (Screen.width*0.5-
51,15%,250,25), "Klik E untuk membuka pintu);

}

function changeDoorState()
{ b

if (doorlsClosed==true)

theDoor.animation.CrossFade ("Open") ;
doorisClosed = false;

yield WaitForSeconds (3);
theDoor.animation.CrossFade ("Close") ;

Gambar 4.55 Tool Rotation di kanan bawah objek polySurfacel

; doorIsClosed = true; 0. Jadikan animasi Open dan Close sebagai Legacy jika keluar
} peringatan untuk membuat animasi menjadi Legacy.
21. Pisahkan objek Trigger dari objek polySurfacel sehingga objek l. Selanjutnya, tambahkan komponen Animation di objek
Trigger tidak menjadi child lagi. polySurfacel.
22. Selanjutnya, Anda akan membuat animasi membuka pintu. KIlk ¢. Daftarkan animasi seperti Gamabar 4.56.
objek polySurfacel dan buka jendela Animation. Buat animanl
dengan nama “Open”.

23. Tambahkan komponen Rotation pada jendela Animation seperll
Gambar 4.54.

24. (bah Center menjadi Pivot pada pilihan di sebelah tool shortcut. | '

Gambar 4.54 Mengganti Center menjadi Pivot

Gambar 4.56 Mendaftarkan animasi

25. Buat pintu terbuka di titik 20 detik dan hapus key di titik 1 menit. k .
. Pada objek Trigger daftarkan objek polySurfacel dalam
26. Klik Ctrl+S untuk menyimpan animasi. komponen DoorLogic.
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Gambar 4.57 Mendaftarkan objek polySurfacel

34. Klik tombol Play untuk menjalankan game.

35. Jika Anda melakukannya dengan benar, pintu akan terbuka saat
Anda klik tombol E dan dalam beberapa detik akan tertutup
kembali.

4.7 Membuat Menu Respawn

Menu ini merupakan kelanjutan saat karakter mati. Pada saat karakter
mati, seharusnya permainan berhenti dan Anda dapat memilih untuk
respawn atau memulai lagi dari awal. Untuk lebih jelas, ikuti langkah-
langkah berikut:

1. Klik objek Player dan buat Javascript dengan nama
“RespawnMenu’”.

Gambar 4.58 Menambahkan komponen skrip Respawn Menu

2. Buat variabel seperti berikut.

var lookAround01 : MouseLook;
var lookAround02 : MouseLook;
var charController : CharacterController;

static var playerlsDead = false;
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Variabel lookAround digunakan untuk membatasi pergerakan
karakter menggunakan mouse. Jika variabel ini tidak aktif,
pengendalian karakter dengan mouse akan dibatasi.

- Buat fungsi Start seperti berikut.

function Start ()

{
lookAround0l =
gameObject .GetComponent (MouseLook) ;
lookAround02 =
GameObject.Find("MainCamera") .GetComponent (MouseLook) ;
charController =
?ameobject.GeLComponent[CharacterController);

Kembali ke Unity. Pada jendela Hierarchy ubah nama objek Main
Camera yang menjadi child dari objek Player. Ganti nama objek
menjadi “MainCamera”.

Kembali ke skrip RespawnMenu.
Tambahkan fungsi onGUI seperti berikut.

function OnGUI ()
%E {playerlsDead == true)

if (GUI.Button(Rect (Screen,.width+0.5-50,
200-20, 100, 40), "Respawn"))

RespawnPlayer () ;

}

if (GUI.Button(Rect (Screen.width+*0,5-50,
240, 100, 40), "Menu"))

Debug. Log ("Return to Menu") ;

}

Skrip di atas akan menampilkan dua menu pada layar, yaitu
Respawn di bagian atas dan Menu di bagian bawah.

Selanjutnya, buat fungsi Update di atas fungsi Start seperti berikut.

function Update ()

?f (playerlsDead == true)
lookAround0Ol.enabled false;
lookAround02 .enabled false;

charController,enabled = false;
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}

Fungsi ini akan mematikan semua gerakan mouse dan keyboard
saat karakter dalam kondisi mati atau variabel characterlsDead

aktif.
Tambahkan variabel baru seperti berikut.

var respawnTransform : Transform;

Buat fungsi characterisDead pada bagian paling bawah.

function RespawnPlayer ()

transform.position respawnTransform.position;
transform.rotation respawnTransform.rotation;
gameObject .SendMessage ("RespawnStats") ;
lookAroundOl.enabled = true;
lookAround02.enabled = true;
charController.enabled = true;

playerIsDead = false;

Debug.Leg("Player telah muncul kembali');

}

Fungsi di atas akan menampilkan pesan yang akan muncul saal

karakter berhasil reespawn.

}

function OnGUI ()
if (playerIsDead == true)

if (GUI.Button (Rect (Screen.width*0.5-50,
200-20, 100, 40), "Respawn"))

RespawnPlayer () ;

}

if (GUI.Button(Rect (Screen,.width*0.5-50,
240, 100, 40), "Menu'))

Debug.Log ("Return to Menu");

}

function RespawnPlayer ()

transform.position = respawnTransform.position;
transform.rotation = respawnTransform.rotation;
gameObject .SendMessage ("RespawnsStats") ;
lookAround0l.enabled = true;
lookAround02.enabled = true;
charController.enabled = true;

playerIsDead = false;

Debug.Log ("Player telah muncul kembali');

}

10. Skrip lengkap dari RespawnMenu seperti berikut.
. Selanjutnya, buka skrip PlayerLogic di objek Player. Ubah skrip
seperti berikut.

#pragma strict

var lockAround0l1l : MouselLook;
var loockAround02 : MouseLook;

#pragma strict
var charController : CharacterController;
var MaxHealth = 100;

var respawnTransform : Transform; var Health : int;

static var playerlsDead = false; function Start ()

function Start () Health = MaxHealth;

}

function ApplyDammage (Damage : int)

loockAround0l =
gameObject .GetComponent (MouseLook) ;
lockAround02 =
GameObiject.Find("MainCamera") .GetComponent (MouseLook) ; Health -= Damage;
charController = 1 if (Health < 0)
?ameobject.cetComponent(CharacterController):

Dead() ;
function Update () ‘ }

if (playerlsDead == true) i function Dead ()
lockArocund0l.enabled = false;
lockAround02.enabled = false;
charController.enabled = false; )

RespawnMenu.playerlsDead = true;
Debug.Log ("Karakter Terbunuh");
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function RespawnStats () . Untagged
Health = MaxHealth;
} gy Finish
EditorOnly
Bedasarkan skrip di atas, Anda akan.memiliki dua variabel darl MilaEarers
nyawa karakter, yaitu MaxHealth dan Health. MaxHealth adalah Player
nyawa maksimum karakter. Health adalah nyawa karakter saat ini, GameController
di mana akan berkurang saat terkena serangan. Pada fungsi dead Add Teg...

menjelaskan kondisi kemunculan respawn, yaitu saat karakter matl,
Pada fungsi RespawnStats mengembalikan supaya nyawa karaktef
kembali penuh setelah respawn.

Gambar 4.60 Memilih tag

. Daftarkan objek Respawn Location ke skrip Respawn Menu bagian

12. Selanjutnya, buat objek baru dengan klik GameObject > Empty
Respawn Transform.

Object.
13. Letakkan di dekat posisi karakter saat ini dan ganti nama menjadi
“Respawn Position" seperti Gambar 4.59.

14. Anda dapt membuat tag khusus untuk objek ini dengan cara klik
menu tag pada jendela Inspector dan pilih tag yang sesuai. Jika
tidak ada tag yang sesuai, klik Add Tag dan tulis nama tag.

l

Gambar 4.61 Mendaftarkan game objek

Klik Play untuk menguiji game. Jika Anda klik tombol Respawn saat
karakter mati, Anda akan kembali muncul di posisi Respawn
Location dengan nyawa penuh kembali.

Gambar 4.59 Meletakkan posisi Respawn Position

15. Klik kembali objek dan pilih tag seperti Gambar 4.60.
Gambar 4.62 Pesan respawn karakter berhasil

132 133




4.8 Membuat Karakter Terluka Saat Jatuh e U L

Pada saat karakter terjatuh, Anda dapat membuat karakter terluka. F v

pembahasan ini Anda akan membuat karakter terluka saat terjatuh,
ini menghasilkan pengurangan pada nyawa karakter tergantung #
seberapa tinggi karakter terjatuh. Untuk lebih jelas, ikuti langkah-lang

|

berikut:
1. Klik objek Player dan buat Javascript dengan n
“CrouchHeight".
2. Tuliskan skrip berikut. |
Gambar 4.63 Posisi karakter menunduk
#pragma strict J > 2
Perlu Anda perhatikan. Karakter dapat jatuh dari permukaan tanah
private var charController : CharacterController; s o mbuktikannya
private var theTransform : Transform; jlka posisi karakter te.rlalu rend'ah. Anda dapat me y:
private var charHeight : float; dengan membuat objek seperti tembok dan membuat karakter
function Start () berdiri di objek tersebut. Jika karakter merunduk terlalu lama,
karakter akan jatuh dari objek.
theTransform = transform;
charController =
GetComponent (CharacterController) ;
charHeight = charController, height;
}
function Update ()
var h = charHeight;
if (Input.GetKey("c"))
{
h = charHeight*0.5;
}
var lastHeight = charController, height;
charController.height =
Mathf.Lerp (charController.height, h, S5*Time.deltaTime :
theTransform.position.y += Gambar 4.64 Karakter terjatuh dari objek
(charController. height-lastHeight) /2;
Selanjutnya, buat Javascript di objek Player dan beri nama
Bersarkan skrip di atas, Anda dapat menekan tombol C pa “WalkerEnchanted”.
keyboard untuk membuat karakter menunduk. Saat menund
ka)r,:kter Anda menjadi lebih pendek dari seharusnya Masukkan variabel berikut untuk mengatur pergerakan karakter saat
terjatuh dari permukaan landai.
3. Jika Anda jalankan, saat Anda menekan tombol C, Anda al
melihat pandangan karakter menjadi lebih rendah. var walkSpeed = 6.0;
var runSpeed = 11.0;
var crouchSpeed = 3.0;
var limitDiagonalSpeed = true;
var enableRun = true;
var enableCrouch = true;
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var jumpSpeed = B.0; {
var gravity = 20.0; if (Vector3.Angle (hit.normal,
var enablefallingDamage = true; Vector3d.up) » slidelimit)
var fallingDamageThreshold = 10.0; sliding = true;
var fallingDamageMultiplier = 2; ‘ }
var slideWhenOverSlopeLimit = false; 4 else
var slideOnTaggedObjects = Ealse,
var slideSpeed = 12.0; Physics.Raycast (contactPoint +
var airControl = false; Vector3.up, -Vector3.up, hit);
var antiBumpFactor = .75; if (Vector3.Angle(hit, K normal,
var antiBunnyHopFactor = 1; ) Vector3.up) » slideLimit)
sliding = true;
7. Selanjutnya, tambahkan private variabel seperti berikut. }
if (falling)
private var moveDirection = Vector3.zero;
private var grounded = false; falling = false; o
private var controller : CharacterController; AE (myTransform.position.y <
private var myTransform : Transform; fallStartLevel - fallingDamageThreshold &&
private var speed : float; ' enableFallingDamage == true) )
private var hit : RaycastHit; 1 ApplyFallingDamage
private var fallStartlLevel : float; (fallstartLevel - myTransform.position.y);
private var falling = false;
private var slideLimit : float;
private var rayDistance : float; if (Input.GetKey(KeyCode.LeftShift) &&
private var contactPoint : Vector3; enableRun == true)
private var playerControl = false;
private var jumpTimer : int; speed = runSpeed;
private var charHeight : float; }
else
8. Buat fungsi Start seperti berikut. ) if (Input.GetKey("c") && enableCrouch ==
i true) (
el %" speed = crouchSpeed;
controller = GetComponent (CharacterController); !
myTransform = transform; 1
speed = walkSpeed; ‘ B84R0

rayDistance = controller.height * .5 +
controller.radius; )
slideLimit = controller.slopeLimit - .1;

jumpTimer = antiBunnyHopFactor; s {£ ( i
= (sliding && slideWhenOverSlopeLimit)
olkdbas transform.position; I || (slideOnTaggedObjects && hit.collider.tag == "Slide")

speed = walkSpeed;

var hitNormal = hit.normal;
moveDirection =
9. Buat fungsi FixedUpdate seperti berikut. Vector3 (hitNormal.x, -hitNormal.y, hitNormal.z);
Vector3.OrthoNormalize (hitNormal,

moveDirection) ;
function FixedUpdate () moveDirection *= slideSpeed;
‘ playerControl = false;
var inputX = Input.GetAxls("Horizontal"); ‘ }
var inputY = Input.GetAxis("Vertical');
var inputModifyFactor = (inputX != 0.0 && inputY else
!= 0.0 &% limitDiagonalSpeed)? .7071 : 1.0; {
moveDirection = Vector3 (inputX *
if (grounded) inputModifyFactor, -antiBumpFactor, inputy *
{ inputModifyFactor) ;
var sliding = false; moveDirection =
if (Physics.Raycast (myTransform.positiaon, myTransform.TransformDirection (moveDirection) * speed;
-Vector3.up, hit, rayDistance)) playerControl = true;
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}
if (!Input.GetButton("Jump"))

jumpTimer++;
else if (jumpTimer >= antiBunnyHopFactor)

moveDirection.y = jumpSpeed;
jumpTimer « 0;
else
if (!falling)
{
falling = true;

fallStartLevel =
myTransform.position.y;

Gambar 4.65 Variabel yang mempengaruhi kejatuhan karakter

if (airControl && playerControl)

moveDirection.x = inputX * speed *

Jika Anda letakkan karakter pada daerah yang tinggi §ehingga
karakter terjatuh, maka karakter akan mendapat luka sesuai dengan
ketentuan pada fungsi ApplyFallingDammage.

inputModifyFactor;

moveDirection.z = inputY * gspeed ¢
inputModifyFactor;

moveDirection =
myTransform. TransformDirection (moveDirection) ;

}

moveDirection.y -= gravity * Time.deltaTime;
grounded = (controller.Move (moveDirection *
Time.deltaTime) & CollisionFlags.Below) != 0;

}
10. Selanjutnya, tulis skrip berikut.

function Update ()

function OnControllerColliderHit (hit
ControllerColliderHit)

Gambar 4.66 Karakter berada di tempat tinggi

contactPoint = hit.point;

}

function ApplyFallingDamage (fallDistance : float)

Jika Anda meletakkan karakter terlalu tinggi, nyawa karakter akan
habis.

gameObject.SendMessage ("ApplyDammage" ,
fallDistance*fallingDamageMultiplier);

Debug.Log ("Anda terjatuh" + fallDistance + *
units!");

11. Jika Anda lihat komponen Walker Enchanted, Anda akan melihal
banyak variabel yang mempengaruhi keadaan saat karakter
terjatuh.
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Gambar 4.67 Pesan karakter terbunuh karena terjatuh

14, Saat meluncur dari lantai yang landai, karakter akan bergerak lel
cepat.

Gambar 4.70 Karakter meloncat saat meluncur

Membuat Perubahan Siang Malam

‘pembahasan ini Anda akan membuat dalam dunia game menjadi
I siang dan malam. Untuk membuat sistem ini, Anda akan
ung menggunakan paket Unity yang siap digunakan. Untuk lebih
Jikuti langkah-langkah berikut:

lambahkan paket Unity yang berisi folder siang dan malam dari file
yang Anda download pada Bab 3.

Jika Anda berhasil menambahkan paket, Anda akan mendapatkan
plder baru yang berisi bahan untuk membuat kondisi siang dan
malam seperti Gambar 4.71.

Gambar 4.68 Karakter sedang meluncur

15. Jika lantai terlalu landai, karakter akan tergelincir.

Pada folder tersebut Anda akan melihat gambar dan material untuk
buat bulan dan matahari.

Gambar 4.71 Paket untuk membuat siang dan malam

Gambar 4.69 Karkater tergelincir saat menaiki permukaan lantai lan

objek Directional Light dan buat Intensity menjadi “0.05".
16. Karakter juga dapat meloncat saat meluncur.
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Gambar 4.72 Mengurangi intensitas cahaya

Saat ini kondisi peta menjadi lebih gelap.
Tambahkan prefab TOD ke dalam jendela Hierarchy.
Anda akan melihat objek berada di peta.

Gambar 4.73 Komponen ditambahkan ke dalam jendela Hierarchy

8.
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Jika Anda klik tombol Play Anda akan melihat pergantian wa
dari siang dan malam.

Gambar 4.74 Tampilan siang

Gambar 4.75 Tampilan malam

Gambar 4.76 Petunjuk pergerakan waktu siang dan malam
Jlka Anda lihat pada Gambar 4.75, yaitu waktu malam, kondisi
Jangit masih terlihat terang meskipun di bawah terlihat gelap.

Untuk mengatasi permasalahan pada awan, hapus komponen
Skybox yang ada di MainCamera dari objek Player.

| O lnspec{or e
il ™ MainCame
Tag | MainCamera ¢ | Layer [Dafault 4
Prefab | Sslect |  Reverr | Apply .
¥~ Transt : Lo
‘ position X 0  |¥l0.907081270 |
Rotation X 0 Yo zZo
Scale. X1 Bria . B
)iﬂf!’zm Lo
» b M GUILayer ﬁﬂf_
» m MFlare Layer °.
» | MMouse Look (script) WO
'3“&“!. Listener Qe

Gambar 4.77 Komponen Skybox telah dihapus

Klik Play dan Anda akan melihat langit menjadi gelap saat malam.
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12.

13.

14.
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Gambar 4.78 Tampilan malam dengan langil gelap

Selanjutnya, ubah warna Background dari komponen MainCa

objek Player untuk mengubah warna langit. Gunakan warna |

langit.

Gambar 4.79 Mengubah warna langil pada MainCamera

Anda dapat mengatur kecepatan pergantian siang dana ma
dengan mengganti nilai dari variabel pada skrip TOD.

Gambar 4.80 Pengaturan skrip TOD

Berdasarkan Gambar 4.80 Anda dapat mengatur kecepatan sl
dan malam dengan mengubah nilai Speed. Anda juga du

elihat jam dalam game dengan melihat nilai pada Hour. Sun
erupakan bagian yang mendaftarkan objek matahari. Slider
ituk melihat pergerakan objek.

ida juga dapat mengatur wama pada bagian bawah dari
ngaturan TOD.

Gambar 4.81 Pengaturan warna langit saat pergantian waktu

da bagian paling bawah Anda ada Skybox yang digunakan untuk
menampilkan waktu siang dan malam.

Sky Pox Material 1 !Onlwﬂogqm_ip_g‘- o
ﬁil@fﬁf&dﬂ: ‘W MorningToMidd. ©
Sun Night
Sun Day 7

Gambar 4.82 Pengaturan Skybox

anjutnya, akan dibahas mengenai bagian-bagian dari skrip. Pada
bagian variabel, Anda akan melihat variabel-variabel berikut.

var slider : float;

var slider2 : float;
var Hour : float;
private var Tod: float;

var sun: Light;
var speed = 50;

var NightFogColor : Color;

var DuskFogColor : Color;
var MorningFogColor : Color;
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lenderSettings.skybox.SetFloat (*_Blend", 0):
lendersSettings.skybox.SetFloat ("_Blend", (Tod/2)-2);
oxMateriall.SetColor (" Tint", Color. Lerp (NightTint,
kTint, (Tod/2)-2) );

Settings.ambientLight = Color.Lerp
ghtAmbientLight, DuskAmbientLight, (Tod/2)-2];
lendersettings.fogColor = Color.Lerp

[NightFogColor, DuskFogColor, (Tod/2)-2);

«'Qampilan Senja

var MiddayFogColor : Color;

var NightAmbientLight : Color;
var DuskAmbientLight : Color;
var MorningAmbientLight : Color;
var MiddayAmbientLight : Color;

var NightTint : Color; =~
var DuskTint : Color;
var MorningTint : Color;

var MiddayTint : Color; (de>6&&Tod<8)

var SkyBoxMateriall : Material;
var SkyBoxMaterial2 : Material;
var SunNight : Color;

var SunDay : Color;

ﬂ nderSettings.skybox=SkyBoxMaterial2;

: erSettings.skybox.SetFloat ("_Blend", 0);
rSettings.skybox.SetFloat (" _Blend", (Tod/2)-3);
8kyBoxMaterial2.SetColor (" _Tint™, Color Lerp

. . (D skTint,MorningTint, (Tod/2)- 3) i)
Variabel-variabel di atas menunjukkan pengaturan dari kondisi Rendersettings. aE\bientLight = Color.Lerp

dan malam yang dibahas sebelumnya. (DuskAmbientLight, MorningAmbientLight, (Tod/2)-3);

RenderSettings. fogColor = Color.Lerp
18. Pada bagian fungsi GUI, Anda akan melihat skrip berikut.

(DuskFogColor, MorningFogColor, (Tod/2)-3);
J/Tampilan Pagi

fungtton oneux () i if('rodws.s.'rodam

handerSettings.ambientLight = MiddayAmbientLight;
RenderSettings. skybox=SkyBoxMaterial2;
Rendersettings.skybox.SetFloat ("_Blend", 1);
8kyBoxMaterial2.SetColor ("_Tint", Color.Lerp
(MorningTint,MiddayTint, (Tod/2)-4) );
RenderSettings. ambientLight = Color.Lerp
(MorningAmbientLight, MiddayAmbientLight, (Tod/2)-4);
‘RenderSettings.fogColor = Color,Lerp
(MorningFogColor MiddayFogColor, (Tod/2)-4);

?f(slider >= %.0)

slider = 0;

}

slider= GUI.HorizontalSlider( Rect (20,20,200,30), sll
0,1.0);

Hours= élider'24;

Tod= slider2+24;

sun.transform. localEulerAngles = Vector3((slider*360
0, 0);

slider = slider +Time.deltaTime/speed;

sun.color = Color.Lerp (SunNight, SunDay, slider*2};

//Tampilan Tangah Hari

Fungsi ini mengatur tampilan gambar pergantian siang dan mal l

Bagian slider akan mengatur pergerakan matahari dan bulan. erdasarkan skrip di atas, pada saat nilai TOD < 4 Anda akan

dan TOD menjelaskan perhitungan waktu pergantian siang 1 tampilan dunia game dalam kondisi malam hari. Pada saat

malam. OD antara 4 dan 6, Anda akan melihat tampilan senjata. Pada

19. Selanjutnya, An at TOD 6 dan 8, Anda akan melihat tampilan pagi hari. Pada saat
R, A e e 'OD 8 dan 10 Anda akan melihat tampilan tengah hari.

if (Tod<4)

//Tampilan Malam o .
’ RenderSettings.skybox=SkyBoxMateriall; ) Memperbalki Desain Tamp"al'l Peta
RenderSettings.skybox.SetFloat (" Blend", 0); A

SkyBoxMateriall.SetColor (" _Tint", NightTint);

| RenderSettings.ambientLight = NightAmbientLight ;
RenderSettings. fogColor = NightFogColor;

)embahasan ini Anda akan melakukan perubahan pada tampilan
Anda akan menambahkan beberapa objek dan menambahkan air
. Untuk lebih jelas, ikuti langkah-langkah berikut:

if (Tod>4&&Tod<6)

RenderSettings.skybox=SkyBoxMateriall;




1. Untuk menghias peta, tambahkan asset dari file yang
download pada Bab 3.

2. Anda akan melihat folder aset untuk menghias peta.

Gambar 4.83 Folder asset

Klik folder CampFire.

Letakkan prefab CampFire ke dalam peta. Gambar 4.85 Menempatkan partikel pada api unggun

Kemudian berikan tekstur pada prefab sehingga objek api ungy

menjadi berwarna seperti Gambar 4.84, vah warna partikel menjadi jingga atau merah supaya warnanya

lihat seperti api.
bah Start Speed menjadi “2".
bah Start Size menjadi “3".

Ik pada bagian Shape dan pilih bentuk Cone supaya api unggun
pnyala ke atas. (Ubah ketinggian cone sesuai dengan yang Anda
1ginkan.

Selanjutnya, klik GameObject > Particle System.

Anda akan melihat partike kecil yang melayang. Tempatkan p
partikel ke posisi api unggun.

eri tanda pada Random Direction pada pengaturan Shape.

Gambar 4.84 Tampilan objek api unggun

Gambar 4.86 Membuat api
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15.

16.
17.

150

Klik folder Stone dan tambahkan batu pada peta.
sukkan prefab Stone pada jendela Scene.

Tambahkan tekstur pada objek batu.

Gambar 4.87 Pengaturan particle system

Klik folder Fence.

Masukkan prefab Fance ke dalam jendela Scene. Jika terlalu ke

gunakan Scale Tool untuk memperbesar objek. Gambar 4.89 Menambahkan objek batu pada peta

Jika Anda ingin memperbanyak pagar, klik kanan pada objek Fa
dan pilih Duplicate. Klik folder StreetLamp dan tambahkan lampu pada peta.

Beri tekstur pada setiap pagar. ‘Masukkan prefab StreetLamp pada jendela Scene.

Tambahkan Mesh Collider pada setiap Fance. Tambahkan tekstur pada lampu.

Gambar 4.88 Menempatkan pagar pada peta Gambar 4.90 Menambahkan objek lampu




24. Duplikasikan objek jika Anda ingin memberikan lebih darl

g prefab Daylight Simple Water ke jendela Scene.
lampu.

il supaya objek air berada di atas tanah sehingga air terlihat di

25. Klik pada bagian lampu. Nama default objek lampu ad
Cube_003.

26. Klik kanan dan pilih Light > Spotlight.*
27. Pada bagian Range isi dengan “10".
28. Pada bagian Intensity isi dengan”4".

Gambar 4.93 Menambahkan objek air

imbahkan tekstur pada objek air dari folder Material.

Gambar 4.91 Meletakkan objek lampu pada pela

29. Selanjutnya, Anda akan menambahkan air pada peta. Klik ka
pada jendela Project dan klik Import Asset > Water (Basic).
30. Klik Import pada kotak dialog yang muncul.

31. Anda akan melihat folder untuk membuat air. Gambar 4.94 Menambahkan tekstur pada air

i ggikan daerah sekitar air dengan klik Terrain dan gunakan tool
'aint Height.

Haluskan permukaan tanah dengan Smooth Height.

Gambar 4.92 Asset untuk membuat air
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Gambar 4.95 Meninggikan daerah sekitar air Gambar 4.96 Tampilan air pada malam hari

37. Buka kembali skrip TOD yang ada di objek TOD.
38. Tambahkan variabel seperti berikut.

var Water : GameObject;
var IncludeWater = false;
var WaterNight : Coloxr;
var WaterDay : Color;

Variabel di atas untuk mendaftarkan objek air di skrip TOD dan juga
mengatur pengaruh air pada saat siang dan malam.

39. Selanjutnya, tambahkan skrip berikut.

Gambar 4.97 Tampilan air pada saat siang hari

if (IncludeWater == true)

Water.renderer.material .SetColor (" horizonColor",

Color.lLerp (WaterNight, WaterDay, slider2#2-0.2)); . Anda dapat menambahkan perahu di objek air. Gunakan objek dari

folder start area > Chinese Boat.

Skrip di atas akan memberikan efek pada air saat kondisi siang daf
malam.

Drag prefab Chinese Boat ke jendela Scene dan perbesar
menggunakan Scale Tool.

40. Klik tombol Play untuk menguji game. . Berikan tekstur pada objek.
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Gambar 4.98 Menambahkan objek perahu

Tambahkan juga objek dock dari folder Dock.

Scale Tool.

. Berikan tekstur pada objek.

Gambar 4.99 Tampilan air lengkap dengan perahu dan dermaga

4.11 Perbaikan Objek pada Peta

Jika Anda uji game, Anda akan menemukan benda yang baru saja
ditambahkan dapat ditembus oleh karakter. Untuk mengatasinya, Anda
perlu menambahkan komponen collider pada bagian benda yang

seharusnya tidak dapat dilewati oleh karakter. Untuk lebih jelas, ikull
langkah-langkah berikut:
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. Drag prefab Dock je jendela Scene dan perbesar menggunakail

Pada api unggun, tambahkan Mesh Collider pada bagian tempat
kayu dan kayunya.

Pada objek batu, tambahkan Mesh Collider pada objek batu.

Pada lampu jalan, tambahkan Mesh Collider pada bagian tiang
ampu.

Pada dermaga, tambahkan Mesh Collider pada setiap child dari
bbjek Dock.

Pada perahu, tambahkan Mesh Collider pada setiap child dari objek
Chinese Boat.

A Anda lakukan hal-hal di atas, objek-objek tersebut tidak dapat
imbus oleh karakter. Untuk beberapa objek seperti dermaga dan batu

ru malah dapat dijadikan pijakan karena objek dapat dilompati oleh
akter.

Gambar 4.100 Karakter berdiri di atas batu

Gambar 4.101 Karakter berdiri di atas dermaga
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Gambar 4.102 Karakter berdiri di atas perahu

N

’ FINISHING

|

mpai saat ini Anda telah mendapatkan game yang dapat dijalankan.
an tetapi, Anda dapat memberikan sentuhan akhir supaya game
njadi lebih menarik. Ada bab ini Anda akan dijelaskan beberapa
ituhan akhir seperti menambahkan tangan, memperbanyak pilihan
, dan sebagainya. Selain itu, Anda juga akan dijelaskan cara
ya game dapat dijalankan secara stand alone.

Menambahkan Tangan untuk Karakter

ini senjata yang digunakan karakter seperti melayang. Pada
mbahasan ini Anda akan menambahkan tangan untuk memegang
njata. Tidak hanya memegang senjata, tetapi tangan ini dapat

gunakan utuk menyerang juga. Untuk lebih jelas, ikuti langkah-langkah
rikut:

Tambahkan folder Arms dari file yang Anda download pada Bab 3.
Tambahkan file Arms05.fbx ke dalam jendela Scene.

Perbesar ukuran objek tangan dengan Scale Tool.
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 ldlewithweapon
Punchiaf

Gambar 5.1 Menambahkan objek tangan pada Scene . -
e

4. Klik gambar Arms05.fbx di jendela Project.
5. Pada jendela Inspector akan terlihat seperti Gambar 5.2. Gambar 5.3 Daftar animasi gerakan tangan
apus animasi Default Take dengan cara klik nama animasi dan
© inspector [T R tanda -
ik animasi Idle dan scroll untuk menunjukkan pengaturan
nimasi.
Beri tanda pada Loop Time dan klik Clamp Range.
Gambar 5.2 Pengaturan Inspector
6. Pada tab Generic pilih Animation Type menjadi Generic.
7. Pada Root nod pilih Arm_Armature > Master.
8. Selanjutnya, klik Apply.
9. Klik tab Animation. Anda akan melihat semua animasi gera

tangan.

Gambar 5.4 Mengatur animasi Idle
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14.
15:

16.
e
18.
19.
20.
21.
22.

24.
2D,
26.
27.

. Pilhan pada langkah 12 akan membuat animasi berjalan tery
setelah waktu animasi selesai. Hal ini dapat dilihat dengan
tombol Play pada gambar animasi bagian bawah jendela Inspe

Selanjutnya, klik animasi IdleWithWeapon.
Klik Clamp Range. :
Selanjutnya, klik animasi PunchLeft.

Klik Clamp Range.

Selanjutnya, klik animasi PunchRight.

Klik Clamp Range.

Selanjutnya, klik animasi Run.

Klik Loop Pause dan Clamp Range.
Selanjutnya, klik animasi Swing01.

Klik Clamp Range.

Selanjutnya, klik animasi Swing02.

Klik Clamp Range.

Klik Apply pada bagian bawah jendela Inspector.

Jadikan objek Arms05 sebagai child dari MainCamera yang ada

objek Player.

. Jadikan juga Melee menjadi child dari MainCamera.

Gambar 5.5 Membuat Arms05 dan melee child dari MainCamera

29. Buat posisi tangan supaya terlihat tepat saat di jendela Game.

Gambar 5.6 Posisi langan saat di game

Selanjutya, pada jendela Project klik kanan dan pilih Create Object
> Animation Controller.
|

Beri nama controller dengan nama “Arms”.

Drag controller Arms ke jendela Inspector Arms05 bagian
Animator.

‘Masukkan pada bagian Controller.

© Inspector

Gambar 5.7 Menambahkan controller untuk animasi tangan

Klik ganda pada file controller Arms untuk menampilkan jendela
Animator.




35.

36.
3.
38.
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Gambar 5.10 Mengatur slate

N
ka Anda melakukannya dengan benar, saat game Anda jalankan,

ingan akan bergerak sesuai dengan animasi Idle.
Gambar 5.8 Jendela Animalor

Klik kanan pada jendela dan pilih Create State > Empty sqy
Gambar 5.9.

Pada jendela Inspector ganti nama "Empty” dengan "Idle".
Tambahkan animasi Idle dari Arms05.fbx.

Drag animasi ke bagian Motion seperti Gambar 5.10.

Vi S S ——

i dic i o o - s thee o

Gambar 5.11 Tangan bergerak menggunakan animasi ldle

Jike posisi tangan kurang pas di layar game, geser posisi tangan
sehingga terlihat jelas pada layar game.

Gambar 5.9 Menambahkan state baru

Gambar 5.12 Memperbaiki posisi langan




41. Tambahkan tekstur pada tangan. Berikan warna tekstur |
Arm_Mesh.

i l Gambar 5.15 Menempatkan kamera di tengah

1 ada bagian Camera, buat Clear Flag menjadi Depth Only.
lik objek Arms05 dan klik Add Layer pada Layer.
etikkan nama layer baru dengan “ArmCamera”.

o

Gambar 5.13 Memberi tekstur pada tangan

5.1.1 Membuat Tangan Tidak Dapat Menembus
Objek

Jika Anda perhatikan, saat karakter menabrak objek, tangan akan ma:
ke dalam objek tersebut. Pada pembahasan ini akan menjelaskan «
mencegah hal itu terjadi. Untuk lebih jelas, ikuti langkah-langkah berlky

1. Buat kamera baru dengan klik Game Object > Camera.

2. Beri nama kamera dengan nama “ArmCamera”.

3. Jadikan kamera kedua menjadi child dari MainCamera. Gambar 5.16 Membuat layer baru

kembali objek Arms05 dan ganti Layer menjadi ArmCamera.

© inspector

A
A

Gambar 5.14 Membual kamera baru

4. Isi bagian Rotaion dan Position dengan “0", sedangkan pa
Scale isi dengan “1".

Gambar 5.17 Mengganti layer menjadi ArmCamera
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Klik ArmCamera dan klik Culling Mask pada bagian Ca
menjadi Nothing.

| 10. Selanjutnya, klik kembali Culling Mask dan klikArmCamera.

11. Pada bagian Depth isi dengan “1". &

12. Hapus komponen Flare Layer, GUILayer, dan Audio Listener d
ArmCamera. ‘

. Jika Anda jalankan game, Anda akan melihat sekarang tangan

lagi menembus objek. Gambar 5.19 Garis pada kiri atas telah hilang

Menambahkan Animasi Gerakan Tangan

smbahasan ini Anda akan menambah berbagai gerakan tangan.
k lebih jelas, ikuti langkah-langkah berikut:

Buka jendela Animator dan buat state baru dengan klik kanan pilih
“reate State > Empty.

N

= Y AT

Gambar 5.18 Tangan tidak menembus objek

. Anda dapat mengubah layer dari senjata dengan ArmCa
sehingga senjata juga tidak dapat menembus objek lain.

T ——

15. Jika Anda perhatikan, pada bagian kiri layar terdapat garis ya
menandakan waktu yang sedang berjalan. Anda daj
| menghilangkannya dengan membuka skrip TOD.

==

__

16. Beri tanda // pada bagian slider= GUI.HorizontalSlid
Rect(20,20,200,30), slider, 0,1.0);.

Gambar 5.20 Membuat state baru

//slider= GUI.HorizontalSlider ( Rect (20,20,200,30],
slider, 0,1.0);

Hour= glider*24;

Tod= slider2+24;

sun. transform. localBulerAngles = Vector3((slider*360) 00,
0, 0);

slider = slider +Time.deltaTime/speed;

sun.color = Color.Lerp (SunNight, SunDay, slider*2);

Beri nama state dengan nama “ldleWithWeapon™.
Pilih animasi IdleWithWeapon.fbx.

. Jika Anda jalankan game, Anda akan melihat garis telah hilang.



langkan tanda pada Atomic.
k Parameters pada jendela Animator dan pilih Bool.

Gambar 5.21 Membuat state baru

4. Klik kanan pada state Idle dan pilih Make Tansition. Gambar 5.24 Menambah p alar
5. Arahkan panah pada state IdleWithWeapon.
eri nama parameter dengan nama “WeaponlsOn".
{embali pada pengaturan transisi. Pada bagian Condition pilih
WeaponlsOn dan beri nilai True.
Gambar 5.22 Membuat transisi
6. Klik garis transisi untuk menampilkan pengaturan transisi.
e T LTI Y— ) | 7 S—————————" Y
Gambar 5.25 Menambahkan parameter baru
Geser garis di bawah Atomic dengan cara scroll mouse ke depan.
Anda akan melihat jarak antar titik menjadi lebih panjang.
‘Pada garis yang memblok biru, perlebar ke kiri supaya transisi
_pergerakan menjadi lebih halus.
Gambar 5.23 Pengaturan garis transisi
170
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kanan pada jendela Animator dan pilih Create State >

Gambar 5.26 Memperhalus transisi

13. Selanjutnya buat garis transisi kebalikan dengan cara klik

state IdleWithWeapon > Make Transision.
‘ Gambar 5.29 Membual state baru

14. Arahkan garis ke state Idle.
ri nama sate dengan nama “Run’”.

[ambahkan animasi Run.fbx.

O inspeter.

Gambar 5.27 Membuat garis transisi baru

15. Klik garis transisi. pada bagian Condition pilih Weaponlst
dengan nilai False.

16. Perbaiki garis di pawah Atomic untuk memperhalus gera
transisi.

Gambar 5.30 Pengaturan state Run

Buat garis transisi dari 1dle ke Run.

Klik garis tersebut untuk menampilkan pengaturan transisi.

Pada bagian Condition pilih {sRunning dengan nilai True.

Gambar 5.28 Mengatur pergantian transisi

17. Klik Parameters pada jendela Animator.

18. Tambahkan parameter baru dengan Klik Bool dan beri nan
“IsRunning”.
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Buat garis transisi dari ldleWithWeapon ke Run.
). Pada bagian Condition tambahkan IsRunning dan beri nilai True.

. Klik garis transisi dari Run ke Idle.
2. Pada Condition tambahkan WeaponlsOn dan beri nilai False.

© Conditians.
| = | isf

e - -

Gambar 5.31 Pengaturan transisi

25. Buat garis transisi dari Run ke Idle.

Gambar 5.34 Mengatur transisi Run ke Idle

33. Klik garis transisi Run ke IdleWithWeapon.

4, Pada bagian Condition tambahkanWeaponlsOn dengan nilai True.

Gambar 5.32 Membuat transisi Run ke Idle

5. Hasil hubungan ketiga animasi akan seperti Gambar 5.35.
26. Pada bagian Condition pilih IsRunning dengan nilai False.

27. Buat garis transisi dari Run ke IdleWithWeapon.

28. Pada bagian Condition tambahkan IsRunning dan beri nilai False.

Gambar 5.35 Transisi anlar animasi

. Klik objek Arms05 dan beri tanda pada Apply Root.
37. Klik tombol Play untuk menguji game.

; IR 38. Pada jendela Animator beri tanda pada IsRunning dan
S [T e—— WeaponlsOn untuk melihat perubahan pergerakan tangan.

Gambar 5.33 Mengatur transisi gerakan Run ke IdleWithWeapon




Gambar 5.39 Membual transisi dari Idle ke Hit02

Buat Parameter baru dengan klik Bool dan beri nama “Hit02".

”‘ Gambar 5.36 Pergerakan tangan saat berlari dan membawa senjata Klik garis transisi Idle ke Hit02.
| h 39. Buat state baru dan beri nama “Hit01". . Pada bagian Condition tambahkan Hit02 dengan nilai True.
40. Tambahkan animasi PunchRight.fbx. Faia =
» 41, Buat Transisi dari Idle ke hit01, S T — ) ]

Gambar 5.40 Kondisi transisi dari Idle ke Hit02

- Selanjutnya buat transisi dari HitO1 ke Idle dan Hit02 ke Idle.
Gunakan Condition default.

| I‘ Gambar 5.37 Membuat transisi dari idle ke Hit01

43. Klik garis transisi Idle ke Hit01.
44. Pada bagian Condition tambahkan Hit01 dengan nilai True.

ﬁ | 42. Buat Parameter baru dengan klik Bool dan beri nama "Hit01".
|I

e Gambar 5.41 Transisi Idle ke Hit01 dan Hit02

| | Conditons
w] {= Lhisol &) Ltrue, | Klik tombol Play untuk menguji game. Jika Anda melakukannya
Il ' dengan benar saat Anda menekan HitO1 atau Hit02, setelah
|' : Gambar 5.38 Kondisi transisi Idle ke HitO1 animasi dilakukan tangan akan kembali ke posisi Idle.

I | 45. Buat state baru dengan nama “Hit02".
" ! 46. Tambahkan animasi PunchLeft.fbx.
th ‘ 47. Buat transisi dari Idle ke Hit02.
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Selanjutnya buat transisi dari Swing01 ke Idle dan Swing02 ke
Idle. Gunakan Condition default.

Klik tombol Play untuk menguji game. Jika Anda melakukannya
dengan benar saat Anda menekan Swing01 atau Swing02, setelah
animasi dilakukan tangan akan kembali ke posisi IdleWithWeapon.

Gambar 5.42 Animasi pergerakan tangan saat memukul

53. Buat state baru dengan nama “Swing01".
54. Tambahkan animasi Swing01.fbx.
55. Buat transisi dari Idle ke Swing01.

Gambar 5.45 Gerakan Swing01

.3 Menambahkan Senjata pada Tangan

da pembahasan ini Anda akan membuat senjata dapat bergerak
ai dengan animasi tangan. Senjata yang akan digunakan merupakan
pjata baru yang dapat Anda peroleh dari file yang Anda download dari
b 3. Untuk lebih jelas, ikuti langkah-langkah berikut:

Tambahkan senjata ke dalam Unity. Pada contoh ini akan
ditambahkan IronMace.fbx.

Hapus komponen Animator dari objek IronMace.

Gambar 5.43 Membuat transisi IdleWithWeapon ke Swing01

56. Pada bagian Condition tambahkan Hit01 dengan nilai True.
57. Buat state baru dengan nama “Swing02".

58. Tambahkan animasi Swing02.fbx.

59. Buat transisi dari Idle ke Swing02.

Gambar 5.44 Membuat transisi IdleWithWeapon ke Swing02

60. Pada bagian Condition tambahkan Hit02 dengan nilai True. Gambar 5.46 Memberl tekstur pada lronMace
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3. K]ik IronMace.fbx di jendela Project. Pada tab Animal da dapat memindahkan Melee menjadi child dari Hold_R dan
hilangkan tanda pada Import Animation dan pada tab Rig b ace menjadi child dari Melee. Akan tetapi non aktifkan semua

Animation Type menjadi None. skrip yang ada di Melee dan juga non aktifkan Sword dan Mace
Beri tekstur pada objek IronMace seperti Gambar 5.46. JERR /nda tidaiClpenagunaian senjataul lag).

5. Selanjutnya, buat objek IronMace menjédi child dari tangan ka
seperti Gambar 5.47.

Gambar 5.49 Susunan child senjala

Gambar 5.47 IronMace menjadi child dari Hold_R Buat posisi Melee dan IronMace tepat di tangan kanan.

6. Semua senjata nantinya akan diletakkan pada Hold R.
7. Buat posisi IronMace tepat di tangan kanan.

mbar 5.50 Posisi senjata tepat di tangan kanan saat tampilan game

Lakukan langkah yang sama dari penghilangan komponen
Animator, pemberian tekstur dan peletakan tangan kanan untuk
senjata lain seperti pisau dan pedang yang ada dalam paket file
yang di-download.

Gambar 5.48 Senjata diletakkan tepat di tangan kanan
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11. Proses peletakan senjata akan seperti Gambar 5.51.

Gambar 5.52 Tampilan dalam game

12. Jika Anda coba menjalankan animasi seperti pada pembahasan
menambahkan animasi gerakan tangan, maka pergerakan senjata
akan sesuai dengan pergerakan tangan.

Gambar 5.53 Pergerakan senjala sesuai dengan pergerakan tangan

.2 Memperbaiki Sistem Senjata

ada pembahasan sebelumnya Anda dapat melukai musuh dengan
njata. Akan tetapi, senjata tersebut tidak dapat bergerak bersamaan
sngan animasi tangan. Pada pembahasan ini Anda akan menggunakan
injata yang baru saja ditambahkan supaya dapat melukai musuh
engan pergerakan sesuai dengan tangan. Untuk lebih jelas, ikuti
ngkah-langkah berikut:

Pada objek Melee yang berada di Hold_R buat Javascript dengan
nama “NewWeaponSwitch".

Gambar 5.54 Membuat skrip NewWeaponSwiltch
Tulisakan variabel seperti berikut.

#pragma strict

var currentWeapon =0;

var maxWeapons = 2;

var theAnimator : Animator;

Variabel currentWeapon merupakan variabel untuk menentukan
senjata yang sedang digunakan. Variabel maxWeapon untuk
membatasi jumlah senjata yang dapat digunakan. Nilai 2 pada
variabel berarti membatasi senjata yang dapat digunakan 3
(ronMace dan Knife). Variabel theAnimator untuk mengatur
animasi gerakan.

Selanjutnya, ketikkan skrip berikut.

function Update ()
if (Input.GetAxis ("Mouse ScrollWheel") <0)
if (currentWeapon +1 <= maxWeapons)

currentWeapon++;

)
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else
currentWeapon =0;
SelectWeapon (currentWeapon) ;

)

else
?f(lnput.GetAxis("Mouae SgrollWheel") >0)

if (currentWeapon - 1 >= 0)
currentWeapon--;
else
currentWeapon = maxWeapons;
SelectWeapon (currentWeapon) ;
Lf (currentWeapon == maxWeapons + 1)
} currentWeapon =0;
if (currentWeapon == -1)
currentWeapon = maxWeapons;

}

function SelectWeapon (index : int)

)

Pada fungsi Update, Anda memberikan pengaturan untuk
pergantian senjata. Cara untuk mengganti senjata dengan scroll
mouse, Pada fungsi tersebut Anda dapat memindahkan senjata darl
senjata utama ke senjata satu atau dua.

Jika Anda klik tombol Play, Anda akan melihat variabel baru pada
jendela Inspector dari Melee. Scroll mouse untuk mengubah
angka. Angka ini mewakili pergantian senjata.

Gambar 5.55 Perubahan angka sebagai pergantian senjata

Anda juga dapat membuat pergantian senjata menggunakan

tombol keyboard dengan menambahkan skrip berikut pada bagian

bawah fungsi Update agar Anda dapat mengganti senjata dengan
menekan tombol 1-2 pada keyboard.

if (Input .GetKeyDown (KeyCode.Alphal))

currentWeapon = 0;
SelectWeapon (currentWeapon) ;

)
if (Input.GetKeyDown (KeyCode.Alpha2))

currentWeapon = 1;
SelectWeapon (currentWeapon) ;

}
if (Input.GetKeyDown (KeyCode.Alpha3))

currentWeapon = 2;
SelectWeapon (currentWeapon) ;

}
Ketikkan skrip berikut pada fungsi Awake.

function Awake ()

SelectWeapon(0) ;

}

Pada fungsi SelectWeapon ketikkan skrip berikut untuk membuat
animasi dari gerakan tangan.

function SelectWeapon (index : int)

for (var i = 0; i < transform.childCount; i++)
if (i == index)

if (transform.GetChild(i) .name ==

{

theAnimator.SetBool ( "WeaponIsOn", false);

"Fists")

else
theAnimator,SetBoel ("WeaponIsOn", true);

transform.GetChild (i) .gameObject.SetActive (true);

else

transform,GetChild (i) .gameObject .SetActive (false)
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} . Klik tombol Play untuk menguji game.

)

Animasi akan dibagi dua, yaitu saat memegang senjata (IronMach
dan Knife) dan tanpa senjata (Fists). WeaponlsOn merupa
kondisi yang menentukan apakah taggan sedang memega
senjata atau tidak.

menggenggam, sedangkan tanpa senjata tangan akan terbuka.

8. Selanjutnya, klik kanan pada Melee yang ada di Hold_R. Kemudi
pilih Create Empty.

9. Beri nama “Fists”". Objek ini akan mewakili tangan saat tid
memegang senjata. Buat semua rotasi dan posisi menjadi 0.

O inpector [N ST

o [Fets ~ | (static v

| Tag | Motsgged | Layer | ArmCameca $ |

o Transform e

| Pasition O T |
::::M »ix.: 5:“: : : Gambar 5.59 Posisi tangan saal senjala Fists (lidak bersenjata)

Gambar 5.56 Posisi dan rotasi objek Fists

~ Fists
~ lronMace
~ Knife

Gambar 5.57 Senjata yang digunakan karakter

10. Selanjutnya, klik Melee dan lihat pada jendela Inspector terdapal
The Animator yang masih kosong.

11. Drag objek Arms05 ke dalam The Animator.

Gambar 5.60 Posisi tangan saal memegang senjata

. Anda dapat mengganti senjata dengan scroll mouse atau menekan
tombol 1-3. Pada saat memegang senjata, tangan akan

4. Selanjutnya, Anda akan membuat skrip supaya serangan karakter

) R dapat melukai musuh. Buat Javascript di Melee dengan nama
% ?m?guu i i n ._LjN-thlq:ggnsuz: “MeleeSystem” atau nama yang Anda inginkan.
S P L ‘ 5. Ketik variabel seperti berikut.

Max Weapon

42z

 The Animator [T Arms05 (Anmato] ©

Gambar 5.58 Menambahkan The Animator
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#pragma strict

var TheDammage : int = 50;
private var Distance : float;

187



16.

17,

18.
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var MaxDistance : float = 1.5;
var TheAnimator : Animator;

var DammageDelay : float = 0.6; yield WaitForSeconds (DammageDelay) ;

var hit : RaycastHit;

var ray =
Camera.main.ScreenPointToRay (Vector3 (Screen.width/2,
Screen.height/2, 0));

if (Physics.Raycast (ray, hit))

Secara umum variabel ini mirip dengan MeleeSystem yang la
Hal ini karena jarak serangan akan dibatasi variabel MaxDistane
dan nilai serangan adalah 50. «

Tambahkan variabel lain seperti berikut. Distance = hit.distance;
if (Distance « MaxDistance)

private var Hit0lStreak = 0;
private var Hit02Streak = 0; hit.transform.SendMessage ("ApplyDammage",

TheDammage, SendMessageOptions.DontRequireReceiver);

}

TheAnimator.SetBool ("Hit01", false);
TheAnimator.SetBool ("Hit02", false);

Variabel di atas digunakan untuk menentukan animasi seranga
karakter.

Buat fungsi Update seperti berikut.
}

Pada bagian atas pernyataan if, menjelaskan pergerakan HitO1 dan

Hit02 secara bergantian. Jika karakter menggunakan senjata, maka

yang dijalankan Swing01 dan Swing02. Kondisi ini aktif secara

bergantian.

Pernyataan if di bawah variabel hit dan Ray menjelaskan formula
supaya senjata dapat melukai musuh. Pada bagian TheAnimator
mengatur pergerakan animasi serangan.

Klik objek Melee untuk membuka jendela Inspector.

function Update ()
%f (Input .GetButtonDown ("Firel"))

AttackDammage () ;
}

Fungsi ini akan memberikan tombol untuk perintah menyerang
yaitu klik kiri.

Selanjutnya, buat fungsi AttackDamage seperti berikut.

function AttackDammage ()

O inspector IS RETRS
' ™ &__M_,Jw

%f (Random.value >= 0.5 && HitOlStreak <= 2)

TheAnimator.SetBool ("Hit01", true); 7‘,
Hit0lStreak += 1; '

Hit02Streak = 0;
else
%f (Hit028treak <= 2)
TheAnimator.SetBoel ("Hit02",
true);
HitO0lStreak = 0;
Hit02Streak += 1;

else

TheAnimator.SetBool ("Hito1",

Hit01Streak 4= 1; G ar 5.61 Melee
Hit02Streak = 0; amb, Skrip pada

} 0. Pada bagian The Animator tambahkan Arms05.

true) ;
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21. Klik tombol Play untuk menguji game. Membuat Game Menjadi Stand Alone

22. Sekarang Anda dapat menyerang musuh dan melukai musuh.
npai saat ini game telah berjalan dengan baik. Anda dapat
snggunakan senjata untuk melawan musuh. Anda juga dapat bergerak
bas mengelilingi peta game. Bagian terakhir yang perlu Anda lakukan
alah membuat game dapat berjalan tanpa membuka Unity.

belum membangun game, Anda dapat menambahkan jumlah musuh
ygan cara menduplikasi jumlah musuh dan mengubah variabel
usuh seperti nyawa dan serangannya.

ptuk membuat game menjadi stand alone, ikuti langkah-langkah
srikut:

Klik File > Build Settings.

Gambar 5.62 Mendekati musuh dengan tangan kosong

File  ESt Assets GammeObject Compe

N Scone Cote ¥
Opan Sconm e
Save Scane Ciilad

Sove Scene w il Shifts S

Peew Project..
Cpen Projet.

Gambar 5.65 Klik File > Build Settings

Selanjutnya, akan muncul kotak dialog Build Settings.

Gambar 5.63 Menyerang musuh dengan IronMace

23. Setelah nyawa musuh 0, maka objek musuh akan menghilang.

Gambar 5.64 Musuh berhasil dikalahkan

Gambar 5.66 Kotak dialog Build Settings
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3. Tambahkan scene game dengan klik Add Current.

* © TP o Ll O IR ¢ s v Q) e evimasy »

Selanjutnya, pilih platform yang akan digunakan untuk menjalanl bRl . apiatle
game. Pada contoh ini tujuan platform adalah sistem ope '.'.':,'.f,, iy S
4 Documerts KRR AT Y Ve \oinee

Windows 32 bit.

5. Klik Player Setting jika ingin menambahkan keterangan lain pe
game. :

Gambar 5.68 Memberi nama game

Klik Save untuk melanjutkan proses.

Euﬁ&ing Player

[l ) o |

Gambar 5.69 Proses memacetkan game

Gambar 5.67 Player Settings

s
/

6.  Klik Build untuk memulai proses pembuatan game menjadi stand
alone.

€ Survival.exe
7. Berikan nama pada game yang Anda buat. Garbar .70 Filsicxs gams

0. Klik file exe untuk menjalankan game.
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Setelah proses selesai, Anda akan mendapatkan file exe.
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nulisbuky Conhiguration x

Geaphics | frpnst

Screen resckition 1034 « %8 v [~ windawed

Graghics cuslty.  {God v Gambar 5.73 Mengganti senjata

Select montor Displary 1 w

[ Pyt ] | qu

Gambar 5.71 Menjalankan file exe

1. Anda dapat mengatur tampilan game pada tab Graphic.

12. Anda dapat melihat tombol yang digunakan dalam game dengar
klik tab Input.

13. Klik Play untuk menjalankan game.

Gambar 5.74 Musuh siap menyerang

Gambar 5.72 Game berhasil dijalankan
Gambar 5.75 Bertarung dengan musuh



.4 Kompilasi Game untuk Android

ada pembahasan ini Anda akan meng-compile game khusus untuk

orm Android. Secara umum game yang telah dibuat dapat di-
ompile pada platform Android, tetapi untuk menjalankan karakter, Anda
erlu mengubah skrip yang mengatur pergerakan karakter menjadi yang
nendukung touchscreen. Jika Anda menemui error pada script saat
'ompile, Anda dapat menghapus script tersebut.

Intuk membuat game yang Anda buat dapat dimainkan menggunakan
serangkat Android, Anda perlu menginstal beberapa hal berikut:

JDK
SDK
Perangkat Android (optional)

Gambar 5.76 Kondisi danau siang hari

5.4.1 Menginstal JDK
JDK (Java Development Kit) merupakan persyaratan utama supaya
da dapat meng-install SDK. JDK dapat Anda download dari situs:

http .//www.oracle.com/technetwork/java/javase/downloads/jdk8-
downloads-2133151.html

Gambar 5.77 Matahari mulal tenggelam Pada t)alaman tersebut, pilih versi JDK yang sesuai dengan sistem
operasi yang Anda gunakan.

Java SE Development Kit Bu60
You must accept the Oracle Binary Code License Agreoment for Java SE to download this

() Accept License Agreement ® peciine License Agreement

Product | File Description File Size Download
Linux ARM vBN7 Hard Fioat ABI 7760MEB  jox-SuB0-Hnue-anmAZ-vip-nit tar g2
Linux ARM v8 Hard Float ABI 7454 MB  jar-BulOdinue-

Linus x86 15466 MB Ak BUBO-NnL-
Linus x86 17483 B [ok-Bubl-linun-

®=
Linux x64 18267 MB  jox-8ub0-linur-x04.rpm
Linux 164 17284 MB g Lhrosn- w88 tar g2
Mac OS X 164 227071MB )-macosx-x64 dimg
Solarls SPARC 84-bit (SVR4 package) 13067MB |@rs-5par tard
Solaris SPARC 64-bit seo2mMB o |ariG-5par
Solans 64 (SVR4 package) 140 1B MB  juk-8L larig-x04
Solarls x64 9671 MB  juk-BuB-solaris-x64 tar gz
Windows 86 180.82 MB  jdx-Bub0-windows (596 exe
Gambar 5.78 Kondisi malam hari Windows x64 1B5 16 MB  je-BuB0-windows-14 exe

14. Klik tanda silang untuk menutup game. Gambar 5.79 Pilihan JDK berbagai sistem operasi
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5.4.2 Menginstal SDK

Untuk meng-compile game menjadi platform Android, Anda perlu
menggunakan root dari SDK sekaligus perangkat virtual Android. Untuk
menginstal SDK, ikuti langkah-langkah berikut: &

1. Anda dapat download SDK dari https:/developer.android.com/sdk/

index.html.
#o oy .

S Android Gambar 5.81 Tampilan Android Studio

= add-ons LN 1% G File toider

L buikd-toals g

s docs

e et 12092015422 Flie toldes

it platforms LONS 0607 e folder

e plattorm-toals 13, L "- File folde

RE= § Fystem-umages l:: |:
Gambar 5.80 Situs untuk download SDK ' S
] W AVD Manager exe “Pﬁ‘j""‘" r’ : :
2. Setelah berhasil menginstal SDK, Anda akan melihat Android TR M mapan My

Studio terpasang di komputer. Jika Anda perhatikan, Anda akan
menemui folder Android di dalam drive tempat Anda menginstal Gambar 5.82 Isi dari folder Android
atau di dalam folder user/nama_user/AppData/Local. Pada folder J !
tersebut, Anda akan menemui SDK Manager.exe dan AVD 3. Klik SDK Manager dan install paket yang dibutuhkan, teru‘tama
Manager.exe. HAXM Installer jika HAXM gagal diinstal saat Anda menginstal

Android Studio.
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Gambar 5.83 Aplikasi pendukung virtual Android device

Jika HAXM tidak dapat diinstal, restart komputer Anda dan masuk
ke menu booting. Kemudian buat pilihan Virtualization
Technology menjadi Enabled.

Gambar 5.84 Membuat Virtualization Technology menjadi Enabled

Selanjutnya, Anda dapat kembali menginstal HAXM.

Buka AVD Manager dan ikuti proses pemasangan sehingga Anda
dapat melihat perangkat virtual Android.

B3 Aot Virtusd Cemver GAVD) WMurmges - o x

Toai
Andread Vitual Devices | Deace Delinitions
List of exsting Androd Virtusl Deveed located ot Clsers\adity\ andioid svd

240 Mame Target Narme Pattor.. AN e, CPWAR Crasta
Newss 3 AP 2D .. Google AP (Goaghe nc a0 3 Google APl Intes Atom («85)

Fatresh
A Avesawsble Andieid Vitusl Device. 3¢ An Android Vietusl Device that falled b9 load. Chck Detatly' to see the error

Gambar 5.85 Tampilan AVD Manager

Klik nama perangkat dan klik Start.

Launch Options X

Skini  Nene
Density: 480

Scale display to real size

[] Wipe user data
Launch from snapshot

Save to snapshot

T e

Gambar 5.86 Pengaturan tampilan perangkat Android

Anda akan melihat tampilan smartphone Android di monitor.




Gambar 5.87 Tampilan perangkat Android virtual

5.4.3 Compile Game Menjadi APK

Supaya game dapat dijalankan pada platform Android, Anda akan meng-
compile game ke dalam bentuk APK. Untuk lebih jelas, ikuti langkah.
langkah berikut:

1. Buka Unity dengan perangkan Android virtual masih aktif.
2. Klik Edit > Preference.

Unity Preferences

Extarnal Tools

Colors
Varify Saving Assets

Gambar 5.88 Tampilan Unity Preference

Klik tab External Tools.

[
Unity Preferences

Ganeral | External Serigt Edtor

Editar Attaching
M 1 S
cene Bavpain Santrel Dt Marge

Kays

T
| Ci/users/adicy AppData/localt |

LCi/Piogram Files/davandil 8,01 |

Android SDK Location
Cache Sarver 0K Location

Gambar 5.89 Tampilan tab External Tools
Pada bagian Android SDK Location arahkan ke folder tempat
Anda menyimpan file SDK. File ini berada di dalam folder Android.

Pada bagian JDK Location arahkan ke folder tempat Anda meng-
install JDK. Biasanya berada di dalam Program File.

Tutup External Tools dan klik File > Build Settings.
Klik Player Settings.

Subd Settingy -
| — s “, - e
fipsi. =

A Carreot |

Gambar 5.90 Tampilan Build Setting



Gambar 5.91 Tampilan Player Setting

8. Pada bagian Company Name dan Product Name isi dengan nama 16.

yang Anda inginkan. Pastikan tidak menggunakan spasi.
9. Pada deretan ikon, pilih ikon Android (keempat dari kiri).

17,

Gambar 5.92 Tampilan Player Selting
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0. Pada bagian Bundle Identifier isi dengan dengan format

Company_Name.Product_Name.

. Anda juga dapat memilih minimum level APl yang dapat digunakan

pada perangkat Android.

. Kembali pada Build Setting. Pastikan pilihan ada pada Android.
. Selanjutnya, klik Build.
. Jika Anda telah menginstal JDK dan SDK dengan benar dan

mengarahkan Unity ke folder yang tepat, proses compile akan
berjalan lancar.

. Setelah proses selesai, Anda dapat menemukan file APK di dalam

folder yang Anda pilih untuk menyimpan file saat proses compile.

D tes.apk
Gambar 5.93 File APK game Android

File ini dapat Anda pindahkan langsung ke perangkat Android
supaya dapat dimainkan atau Anda dapat mencobanya pada
perangkat virtual Android.

Jika Anda ingin menguji game pada perangkat virtual Android,
pindahkan file APK ke dalam folder platform-tools yang ada di
dalam fodler sdk.

Ides 12002015 1518 File folder

o VO I018 123 sl folder

b F

systiace MOWXNG 1235 Frig toider
(31 adb.exe 13/09/2015 12.35 Apphcahon W2
|4 AdbWinApdil 137002015 1215 Apphotion estem MR
[T AduwinUsbap.dil VW20 1208 Application extent #0 Kn
W1 dmtracedump exe VO a4 | Apphcation 7K
[¥1 etcitool eee Vo1 5 1248 Apphcanon 1 K
(301 fastboot exe 10N 2015 3 Apphcation n e
3 A7 K8
HE KR

T3] hprof-cony.exe 972019
NOTICE tt
source properties

87 sqinelexn Vo015 108 Appheanion e K
tet.aph MOWEIS 1A APK File 1406 8

Kb

Gambar 5.94 Memindahkan file APK ke dalam platform-tool
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18. Selanjutnya, buka command prompt dan arahkan ke dalam folder
platform-tools. Gunakan perintah “cd” untuk pindah folder.

Gambar 5.95 Pindah ke folder platform-tools

19. Selanjutnya, ketikkan /adb install nama_APK.

20. Jika berhasil, pada perangkat virtual Android akan ditampilkan
game yang telah Anda buat.

e EX:
Y 5"

ustom Locale  Dev Settings Dey Tools Downlosds

I‘?‘: » | a
g,

Email Gallety game 1es

E’ |= 0 \s
Phone

Maos Messenqel Music
Gambar 5.96 Game berhasil dikenali perangkat

21. Klik ikon game untuk masuk ke dalam game.

206

Gambar 5.97 Tampilan game dalam perangkat Android virtual

22. Untuk keluar game Anda harus menutup aplikasi secara manual
karena Anda tidak menambahkan menu untuk menutup game.
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Unity 3D

Berkat Android, kini ponsel tidak hanya untuk bertelepon, tetapi juga bisa diguna
untuk bermain game. Penggunaan Android untuk bermain game pun makin mer
terutama di kalangan anak-anak dan remaja.

Unity 3D sendiri adalah game engine yang cukup populer. Game engine merupa
sebuah software yang digunakan untuk membuat atau mengembangkan ga
Unity 3D banyak digunakan oleh kalangan pembuat game indie maupun ora
yang baru belajar membuat game.

Buku ini menjelaskan cara menggunakan Unity 30, untuk membuat game. A
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